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Chapter 1

Introduction

1.1 What is ICON-NMR?

Welcome to ICON-NMR, a comprehensive user interface, tailormade for all your
NMR laboratory management and control needs. ICON-NMR was designed to make
the execution of routine NMR experiments easy and straightforward by providing
a state of the art icon based user interface. The steps necessary to acquire, process,
and plot a spectrum are reduced to inserting a new sample, defining the data file
name, the solvent, and the experiment. No other knowledge about the instrument,
the parameters, or the software is necessary. Although running on top and under
the control of the computer’s Unix/Windows NT operating system and Bruk
XWIN-NMR program, providing the acquisition and processing functions, ICON-
NMR shields the user entirely from both. Accessing XWIN-NMR commands is only
possible if permission has been granted by the laboratory manager. As such,CON-
NMR is particularly suited for open access spectrometers with a large numb
users.
1
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1.2 Hardware/software requirements

Computer and Operating System: 
Silicon Graphics: Operating System IRIX 5.3, 6.2, 6.3 or 6.5

Personal Computers: Operating System Windows NT Version 4.0 Service Pack 3

Spectrometer: AMX/ARX or Avance

Software:
XWIN-NMR 3.0 must have been installed prior to ICON-NMR 3.0

Release Media:

ICON-NMR 3.0 is available on the NMR-Suite 3.0 CD.

This manual applies to ICON-NMR version 3.0. ICON-NMR contains this manual as
on-line documentation accessible from the Help menu. ICON-NMR 3.0 can only
work if XWIN-NMR 3.0 has been installed prior to ICON-NMR.

ICON-NMR 3.0 provides the Routine Spectroscopy Desktop for experiments without
a sample changer plus the Automation Desktop for both sample changer and man-
ual usage.

1.3 Support

Software support is available from your local Bruker office or via e-mail from the
following address:

nmr-software-support@bruker.de

The Bruker ftp servers ftp.bruker.de and ftp.bruker.com provide additional infor-
mation such as known bugs and their workarounds in the directory 

/pub/nmr/ICONNMR or /pub/nmr/mirror.bruker.de/ICONNMR respectively.

1.4 Installation of ICON-NMR

Please proceed as described in the XWIN-NMR 3.0 release letter. ICON-NMR can be
separately selected as an installation item from the XWIN-NMR installation dialog
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window.

1.5 Starting up ICON-NMR

1.5.1 XWIN-NMR configuration

Before you can start ICON-NMR and begin your work, the laboratory manager must
have installed XWIN-NMR 3.0 and ICON-NMR from the release media. In addition,
the config XWIN-NMR configuration suite (see the XWIN-NMR manual) must have
been executed successfully.

Notes on XWINNMRHOME:

While pre XWIN-NMR 2.0 versions could only be installed in the directory /u,
XWIN-NMR 3.0 can be installed in any directory. When you install XWIN-NMR from
the distribution CD on Unix systems, you may either choose Standard Installation
or User-Defined Installation. The standard directory is /u , the user-defined instal-
lation allows you to specify any directory. In this manual the actual installation
directory of XWIN-NMR with XWINNMRHOME. All program modules of XWIN-
NMR as well as some utility programs such as the Service Tools are located in
XWINNMRHOME/prog and its subdirectories. All parameter sets, pulse programs,
AU programs, etc. are located in XWINNMRHOME/exp and its subdirectories. The
spectrometer configuration files are located in XWINNMRHOME/conf and its sub-
directories. The plotter and printer configurations files are located in XWINNM-
RHOME/plot and XWINNMRHOME/print/ and their subdirectories, respectively.

XWINNMRHOME and /u will be used interchangeably in this manual.

1.5.2 Unix desktop configuration

An ICON-NMR user should have configured his Unix desktop so as to display a
Windows overview box in order to avoid X Window Icons to appearing on his
ICON-NMR desktop.

1.5.2.1 SGI computers

To enable the Windows overview box on SGI systems, please proceed as follows:
Subsequently click on the menu items Desktop -> Customize -> Windows 
in the IRIX Toolchest and check the button Display windows overview in the
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upcoming dialog window. Close the window, thereby restarting the window man-
ager.

The SGI 4D window manager allows a user to enter the key sequence ‘ALT +
cebar’ to open a new Unix window even if the Unix desktop is completely cove
by ICON-NMR. If an ICON-NMR user should be prevented from accessing any ot
programs including Unix, this feature must be disabled using the following pr
dure: Open the file .4Dwmrc in the user’s home directory with a text editor, sear
for the definition of the menu 4DwmRootMenu, and insert a ‘!’ character in front
of the line containing the item new window. The exclamation sign will disable the
new window feature. In addition, insert a ‘!’ character in front of the line conta
ing the item <Btn1Down>, contained in the section Buttons
4DwmButtonBindings. If you do not have a .4Dwmrc file, you’ll find a sample file
in /usr/lib/X11/system.4Dwmrc

1.5.2.2 Windows NT

Here the Start Menu bar will contain the icons for the respective programs
changes to the default configuration are necessary.

1.5.3 Start-up methods

Select one of the following methods to start ICON-NMR.

1. Starting ICON-NMR from Unix/Windows NT level
Open a terminal window and enter the command iconnmr.

2. Starting ICON-NMR from XWIN-NMR level
If X WIN-NMR is active, enter the command iconnmr in its command line, or call
it from the Windows menu using the mouse.

3. Auto-Start ICON-NMR when logging into the workstation
For SGI systems, set up a text file with the name .sgisession in your home
directory. Insert the command iconnmr as the last line of this file. When log
ging in, the system will execute the file and start ICON-NMR.
For Bruker AspectStations, the file name must be .Xsession rather than .sgises-
sion. 
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1.6 System and user management

The first time any user uses ICON-NMR a default user file will automatically be cre-
ated allowing full access to the program. It is recommended, however, that the
Laboratory Manager create userfiles for all users who will be using the program.
All aspects of the software may be configured from the System Manager button of
the ICON-NMR main window and is described in detail in the System manager
chapter of this manual.

System and user management comprises the following items:

• Defining the legal spectrometer users

• Defining the experiments a particular user may execute

• Defining a number of permissions for a user, e.g.
- whether he is allowed to change the parameters of an experiment
- whether he may exit from Routine Spectroscopy/Automation mode to XWIN-
NMR or Unix
- whether he may access the desktop while ICON-NMR is active
- whether he is allowed to lock and shim a sample manually
- file name restrictions

• Defining user specific information, such as e-mail address or a costing gro

• Defining the disk partitions to store the acquired data

• Defining new composite experiments, i.e. several experiments under one nam

• Configuring ICON-NMR’s Automation module and Default Shim file loader

1.7 Using the mouse or the keyboard

Within ICON-NMR, you can use the mouse or the keyboard to select items and
cute commands, and to position the text cursor.

• In order to execute a function represented by an icon or a button or a m
item, either click on it using the left mouse button, or hit the Enter key once it is
selected.

• In order to select the next or previous icon or a button in a window for execu
tion with Enter, use the Tab or Shift +Tab keys.
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• In order to select the next or previous menu item or list box item, use the Down
Arrow or Up Arrow keys, or the left mouse button.

• In order to move the text cursor within text entry fields, use the Left Arrow or
Right Arrow keys, or the left mouse button.

For Automation use only:

• In Automation mode scrolling up and down in the experiment display area m
be done with the Alt + z and Alt + x key combinations respectively.

• Use Alt + Tab in the Title window in Automation mode to select the next button
entry. (Tab on its own is taken as being a normal Tab indent function)

Using Function Keys:

• ICON-NMR does not per default recognize function Key definitions as defi
on the workstation. If ICON is to recognize Function Key input you have
create a resource file called _iconnmrrc in the home directory of the user
normally starts XWIN-NMR for ICON-NMR use.

Here is an example of one such resource file which defines F1 for ICON-N
use. Put both of the following lines in your _iconnmrrc file to be able to use th
key in your Title and Originator entries:

bind Entry <F1> {%W insert insert “This is F1”}

bind Text <F1> {%W insert insert “This is F1”}



Chapter 2

The Main Desktop

2.1 Overview

After starting ICON-NMR using one of the procedures described in the Introduction
chapter of the manual, the ICON-NMR main desktop will appear, showing the icons
in Figure 2.1 as command buttons. The following sections present a short descrip-
tion of the assigned functions. Every function will be discussed in detail in the fol-
lowing chapters of this manual.

The main desktop may cover the entire monitor screen, shielding the user from the
other windows active on the workstation. The desktop has a window manager

Routine 
Spectroscopy

Automation Configuration Accounting

Figure 2.1 Icons of the main desktop
7
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frame, which may be removed via the Supervisor permission, making it is impossi-
ble to move it aside and access other programs. Should this default setting be too
restrictive for a particular user, the laboratory manager can add a window manager
frame to the desktop by activating the Supervisor permission in ICON-NM
User Manager.

You can, of course, reduce the size of the initial window so that it only contain
4 main start buttons as shown in Figure 2.1. ICON-NMR 3.0 retains the size informa-
tion for future use.

2.1.1 Routine spectroscopy

This ICON-NMR mode was designed to help the user perform standard experim
(provided by Bruker or set up by the laboratory manager) by simply following
steps:

- Insertion of the sample into the magnet (manually, no sample changer)
- Defining a file name
- Defining the solvent
- Defining the experiment
- Starting execution

If not configured differently by the laboratory manager, experiment execution 
sists of data acquisition, processing and plotting.

Any experiment will generate an entry in a protocol file, which can be for u
accounting in the System Manager Accounting program.

2.1.2 Automation

This is the extension of Routine Spectroscopy for spectrometers equipped 
without a sample changer. It may be used in a manual mode without a sa
changer as an alternative to the simple Routine Spectroscopy interface.

2.1.3 Configuration

Here you may define experiments and user specific properties of the pro
interface. The Configuration interface consists of a browser style interface 
logical pages of configuration information pertaining to the program
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2.1.4 Accounting

This utility allows the laboratory manager to to generate accounting reports based
on the instrument time used by individual users or groups. It can also be used to
generate a list of experiments which were performed on a particular sample. The
Accounting prog makes use of accounting files stored in the XWINNMRHOME/
conf/instr/<Instrument Name>/inmrusers directory. 

2.1.5 Terminating ICON-NMR

The File menu provides several methods to terminate ICON-NMR:

1. Logout (only available on SGI systems)
Terminates ICON-NMR, XWIN-NMR, and the current Unix session.

2. Exit to Unix
Terminates ICON-NMR and XWIN-NMR and allows you to continue work in the
current Unix session.

3. Exit to XWIN-NMR

Terminates ICON-NMR and leaves XWIN-NMR active and ready for command
input. You may exit any ICON-NMR window using the key sequence (ALT-F, E).

4. Clearing an error situation
Should it happen that for any reason your keyboard and mouse seem to be dead
and you can’t continue work, you should try the following key combination
restart if you are working with an SGI computer: CTRL SHIFT ALT F12
(press all 5 keys simultaneously). On WINDOWS NT, press CTRL-Alt-Delete
and use the task manager instead. If this does not help, but you are conne
a network, you can log into your system from another terminal (using the s
id) and execute the command shmrm from the keyboard. If this is not possible
or does not help, you must turn off the computer and restart it.

2.1.6 Help

The Help menu allows you to access this ICON-NMR manual on line.
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Chapter 3

Routine Spectroscopy

3.1 Entering Routine Spectroscopy mode

You enter Routine Spectroscopy mode by clicking on the respective icon of the
ICON-NMR main desktop. A flashing icon will invite you to identify yourself. To
exit click on the Exit button of the File menu. 

3.2 User identification

3.2.1 Identify yourself

When you click on the identify user icon, a dialog box (Figure 3.1) is opened
which displays a list of possible spectrometer users. Select your user id from the
list either with a single mouse click, followed by a click on the OK button, or dou-
ble click on your ID. The program will then request your password. If your ID
does not appear in the list, use the User Manager, accessible form the Configura-
tion Menu to create a userfile for yourself. 

User ID’s and passwords

The user identification dialog box similar to that shown in Figure 3.1, will cont
11
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the ID’s of all users which have both a Unix account on this workstation and a
file defined using ICON-NMR’s User Manager window. In addition, the bo
includes the ID’s of so-called NMR users. NMR users need not have their ow
workstation account. Instead, they are defined by the laboratory manager i
System Manager mode of ICON-NMR where they are assigned an ID and, if desire
their own password (Unix only).

In other words, legal workstation users may enter Routine Spectroscopy mode, as
well as other people to whom the administrator wishes to grant access to the
trometer by adding them to the NMR users list.

An NMR user who does not have a password must use the effective NMR user’s
password. This is a legal workstation user on the workstation who was defined to
be the effective NMR user by the laboratory manager in the Nmr User Manager

Figure 3.1 User identification
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mode of ICON-NMR.

The user ID selected to get into Routine Spectroscopy mode has a direct influence
on the ownership of the acquired data. If your ID is a legal Unix login ID, the data
will get read/write access permissions for yourself and all members of the Unix
group you belong to. You may alter this using the Umask setting in the User Man-
ager. If you are an “NMR user”, the data access permissions are those of the
tive NMR user.

3.3 The Routine Spectroscopy desktop

3.3.1 The flow chart

If your identification was successful, the window of Figure 3.2 (left side) w
appear on the ICON-NMR desktop containing icons that are arranged as a flow c
in order to guide you in the appropriate way through the set up steps req
before the experiment can be started. As you can see from the flow chart, the
only a few operations to perform: Inserting the sample into the magnet, defin
file name, defining the solvent, and defining the experiment. Then you are rea
click on the start button to execute the experiment. Before that, you may at 
time repeat a set up step to apply any corrections.

The flow chart can be displayed in two modes by clicking the Status toggle button.
The second mode (Figure 3.2, right side) shows a status panel appended
chart which allows you to view the parameters defining the current experime
anyone of them remains undefined (except for the title parameter), you cannot sta
the experiment. Please note that within the status panel no parameters mo
tions are possible.

3.3.2 The File menu

This menu contains the Exit command to terminate the Routine Spectroscopy desk-
top. After successful log in the Exit to Iconnmr button may be used to leave
routine mode without returning to the identify user stage.

3.3.3 The Options menu

This menu contains the following commands:
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• Manual Locking and Shimming
If the check button Manual Lock/Shim is activated, the acquisition software wi
neither lock the field nor shim automatically. These tasks are left to the use
soon as the procedures are required after starting the experiment, a dialo

Figure 3.2 Routine spectroscopy flow charts without/with status panel
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will invite the user to execute them manually. Manual locking and shimming
require a permission to be set in User Manager mode.

• Iconbook (SGI systems only)
This command places a number of utilities onto ICON-NMR’s desktop. They are
presented in form of icons, contained in their own box, e.g. a text editor, a g
or anything else available on the workstation. The contents of the box mu
configured by the system manager at Unix level. The iconbook is only prov
if the laboratory manager enables it in User Manager mode.

• Change password (only available for NMR users)
This command allows the current ICON-NMR user to change his password.

3.3.4 The Configuration Menu

This menu contains the following commands:

• User Manager
Direct access to all the User manager features. Note that you may need to
tify yourself a second time before all changes will take effect. See “The U
Manager” on page 45..

• Composite Manager
Access to composite experiment definition for ICON-NMR. See “The Composite
Manager” on page 57..

• ICON-NMR CONFIGURATION

Use this to define global features of ICON-NMR, like the shimming method to be
used before Acquisition, or the default increment to use for the experim
numbers. See “Configuration Suite” on page 49. for more details.

3.4 The Inject/Eject icon

Figure 3.3 (left side) shows the window which appears when you click on
Inject/Eject Sample icon. 

The window has 2 different modes of operation Manual and Sample Changer
operation. To use the sample changer mode the unit must have been config
using the cfbacs XWIN-NMR command.

The manual mode consists of a command sequence panel, and a command pane
with a flashing frame, inviting you to select a command. Choose either Exit to
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close the window, or Insert Sample to turn on the sample lift. A sample residing in
the magnet will be lifted, and a dialog box will ask you to insert a new sample. The
command sequence panel monitors the actions of the spectrometer during this pro-
cedure.

After the experiment has been successfully completed the Inject/Eject window will
also contain the buttons Eject + Terminate, Use Same/Continue and Insert New
Sample. The Eject + Terminate button ejects the sample from the magnet, and sub-
sequently terminates the current ICON-NMR routine session. Use Same/Continue
increments the experiment number by one leaving the sample in the magnet, while
the Insert New Sample starts the change sample procedure.

3.5 The Filename icon

3.5.1 Selecting the data set name

When you have inserted a sample in the magnet, you must define a data set name
for the fid and spectrum to be acquired. The dialog box of Figure 3.3 (right side)
will be opened as soon as you click on the Filename icon. The data set filename
follows the conventions of XWIN-NMR, where an fid is stored in the directory

/DU/data/USER/nmr/NAME/EXPNO/

The corresponding spectrum is stored in

/DU/data/USER/nmr/NAME/EXPNO/pdata/PROCNO/

DU is the disk unit or partition where the data will be stored. If for a particular user
only a single partition is provided in the User Manager mode, DU will not appear
in the Filename selection box. Otherwise a user may select the desired DU from a
list.

USER is the identification code a user typed in to enter Routine Spectroscopy
mode. It not only defines the location of the data on disk, but also the access rights
for the data (cf. section  for details).

NAME is a string to identify the data files of a particular sample. A user enters the
desired name into the respective text entry field, or selects the name from a given
list by clicking on the Names button right of the entry field. The list is defined for
each user in the User Manager mode. In this mode, the Data Set Edit checkbutton
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can be set, so that a user can only use the names on the list, but not enter his own
particular name. Furthermore, a Spectrum Number file may be set up which auto-
matically assigns a system wide, unique name for each sample used (see Section
4.8).

EXPNO is a number with the default value 10. The purpose of EXPNO is that a
user may keep the same NAME for several experiments, but differentiate the data
by another EXPNO. We recommend you increment EXPNO by 10 to prevent a
conflict with the EXPNO counting used in composite experiments. A composite
experiment actually performs several experiments, e.g. a 1D preparation experi-
ment followed by a 2D. ICON-NMR will increment EXPNO by 1 in these cases.

PROCNO is a number with the default value 1. It need not be changed in Routine
Spectroscopy mode.

3.5.2 The originator information

Several other items may appear in the Filename selection box, such as the Depart-
ment or the Email address in Figure 3.3. This so-called originator information can
be configured in User Manager mode by invoking the Originator Items Editor.
The originator information, if present, will automatically be appended to the plot
title. See “The Originator Items Editor” on page 54..

3.5.3 Command buttons

The Filename box provides the following command buttons:

• OK
Accept all changes and return to the Routine Spectroscopy flow chart.

• Cancel
Discard all changes and return to the Routine Spectroscopy flow chart.

• Continue
Accept all changes and carry on with the next item of the Routine Spectroscopy
flow chart, i.e. open the Solvent selection box.
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3.6 The Solvent icon

3.6.1 Selecting the solvent

The Solvent selection box (Figure 3.4, left side) is shown when you click on the
Solvent icon or on the Continue button in the Filename selection box. Choose the

Figure 3.3 Inject/Eject and Filename dialog boxes
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solvent for your sample.

The solvent list displayed is the list setup by the laboratory manager with the com-
mand edsolv during XWIN-NMR configuration.

Figure 3.4 Solvent and Experiment selection windows
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3.6.2 Command buttons

The Solvent box provides the following command buttons:

• OK
Accept the selected solvent and return to the Routine Spectroscopy flow chart.

• Cancel
Discard the selected solvent and return to the Routine Spectroscopy flow chart.

• Continue
Accept the selected solvent and carry on with the next item of the Routine Spec-
troscopy flow chart, i.e. open the Experiment selection box.

3.7 The Experiment icon

3.7.1 Selecting the experiment

The Experiment selection box (Figure 3.4, right side) is shown when you click
the Experiment icon or on the Continue button in the Solvent selection box. Choose
the desired experiment for your sample.

The experiment list displayed is user dependent and setup by the laboratory
ager in User Manager mode. See “The Experiment List box” on page 47..

3.7.2 What is an experiment?

Each experiment name in the list is associated with a set of acquisition, proce
and plotting parameters stored in the directory

XWINNMRHOME/exp/stan/nmr/par/<experiment name>/

Bruker provides a pool of the most important experiments with its softw
installed at XWIN-NMR configuration time with the command expinstall. The labo-
ratory manager may define additional experiments using the XWIN-NMR eda, edp,
edg, rpar, wpar commands.

Some experiments are denoted as composite experiments defined in the Composite
Experiment Setup mode of ICON-NMR. A composite experiment is a sequence 
normal experiments which you define in Set Composite Experiment mode. The
member experiments of a sequence may depend on each other. For examp
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first experiment of a sequence could be a preparation experiment for a subsequent
2D experiment. In such cases, the composite experiment manager allows the labo-
ratory manager to specify the reference experiment(s).

When an experiment is started, a sequence of preparation steps for data acquisition
are executed, followed by the acquisition of the fid(s), followed by data processing
and plotting. The preparation steps select the preamplifier, adjust the lock, the
shims, and the receiver gain, controlled by the TCL script

XWINNMRHOME/prog/tcl/xwish3_scripts/inmr_scripts/qnmr_sx_tcl

The actual data acquisition is performed by the AU program AUNM which an
acquisition parameter defined in the experiment. AUNM may be modified by
using the eda parameter editor before experiment start.

For processing (Fourier transform, phasing, integration) and plotting, the tcl script
calls the AU program AUNMP, which is a processing parameter of the experiment.
The AUNMP parameter may be modified with the edp parameter editor.

3.7.3 Command buttons

The Experiment box provides the following command buttons:

• OK
Accept the selected experiment and return to the Routine Spectroscopy flow
chart.

• Cancel
Discard the selected experiment and return to the Routine Spectroscopy flow
chart.

• Set Plot Title
A text entry window is opened where you can type in one or several lines w
will become the title of the spectrum plot. The title window will already cont
the originator information if defined. When you terminate the window by clic
ing on its OK button, the title text will be saved in the following file where it
looked up by the plot software:

/DU/data/USER/nmr/NAME/EXPNO/pdata/PROCNO/title

3.7.4 Modifying parameters

After an experiment has been defined, its acquisition, processing, and plo
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parameters are initialized from the standard parameters for this experiment. Using
the commands of the Parameters menu, the parameters can be changed before the
Start icon is activated. The standard parameters sets will not be affected. Parameter
modification requires the governing permission checkbutton to be set in User
Manager mode.

3.8 The Start icon

Once everything is setup correctly, i.e. the sample is in the magnet, file name, sol-
vent, experiment, and plot title are defined, the traffic light in the START icon will
turn green and you may the activate the Start icon to launch the experiment. 

3.8.1 The acquisition in progress window

After starting the experiment, the flow chart will be overlayed by the acquisition in
progress window (Figure 3.5) containing the file name and EXPNO, the remaining
time the experiment needs to finish, the experiment name and its comment line.
The figure shows EXPNO=31, which in this case indicates, that a composite
experiment is in progress: The 1D reference experiment had EXPNO=30.

The window provides the following command buttons:

• FID
Displays the fid being acquired in real time. 

• Spectrum
Displays the spectrum being acquired in real time.

• Lock 
Displays the lock signal in real time.

• Halt
Halts data acquisition when the current fid is complete and stores it on dis
further processing using the Plot button.

• Plot
Processes the fid stored on disk when Halt was pressed and plots the spectru
In fact, the AUNMP AU program is called for this purpose. If processing 
already been carried out, this button merely plots the spectrum afresh.
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• Exit
Returns to the flow chart. This button is not active while the experiment i
progress.

• Stop
Stops all spectrometer activity immediately. No valid data will be availa
afterwards.

• Search
After an experiment has been completed this button may be used to look a
viously acquired spectra.

3.8.2 The acquisition status icons

These icons allow you to observe the current experiment status. Whenever th
gram begins to execute a particular procedure, the corresponding status ico

Figure 3.5 Acquisition in progress window 
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blink until the task has been completed. When processing is finished, the exit but-
ton will be enabled. Using this button will return control to the flow chart for set-
ting up the next sample.

3.8.3 The accounting file

Every experiment started in ICON-NMR will generate an entry in the accounting file

/XWINNMRHOME/conf/instr/<spectrometer>/inmrusers/Inmracct.brief and

/XWINNMRHOME/conf/instr/<spectrometer>/inmrusers/Inmracct.full

The .brief files contain only essential information and are shorter.

Table 3.1 shows the initial section of such a .full file which reports the spectrome-
ter users and the experiments they performed, including the time and disk space
requirements. The file will grow with time, and it is the responsibility of the labo-
ratory manager to archive and delete it periodically. Such accounting files are the
basis for the accounting manager provided by ICON-NMR which generates an
invoice for any user, user group etc. based on unit prices per hour of spectrometer
time and Megabyte of disk usage.

Initialize Lock Shim Gain Acquire Process

Figure 3.6 Acquisition status icons
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--------------------------------------------
----  IconNmr Accounting File

----
----  Created Tue Jan 23 12:31:50 MEZ 1996

--------------------------------------------
#Login

name: mg1
host: bigi

group: user 20
date: 01/23/96 12:32 822396721

--------------------------------------------
#Spectrometer: DPX250

--------------------------------------------
#Experiment

nameOfExperiment: PROTONNREXP
solvent: Acetic

fileName: Mark2076 40 1 u mg1
fileSizeAcq: 32768
fileSizeProc: 16384

NUCLEUS: 1H
INSTRUM: DPX250

timeOfStart: 01/23/96 12:32 822396744
timeOfTermination: 01/23/96 12:33 822396824

#User Specific Info
Email Address: mg@bruker.de

---------------------------------------------
#Logout

date: 01/23/96 12:33 822396838
--------------------------------------------

Table 3.1  Section of an accounting file
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Automation

4.1 Entering Automation mode

Enter Automation mode by clicking on the respective icon of the ICON-NMR main
desktop. A identification window will invite you to identify yourself. To return to
the main ICON-NMR desktop click on the Exit button of the File menu.

4.1.1 User identification

See “User identification” on page 11 for more details on identification requ
ments.

4.2 The Automation Setup Window layout

After successful user identification, the user interface shown in Figure 4.1
appear on the ICON-NMR desktop showing an array of sample holders. The size
the array will depend on what type of sample changing mechanism you 
installed on your instrument see ’Default Number of Sample Holders’ on page
The setup window shows all samples and their respective status in the sy
Available, Queued, running completed or error. You’ll find control buttons to a
change/delete experiments from the setup window experiment list, a histor
27
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giving information on what the instrument actually did and various other control
buttons.

The setup window is the Automation control center. It is the master scheduler for
the instrument. It consists of the following items:

• The window manager bar showing the directory where the automation
information is to be temporarily stored.
This is allocated afresh each time the Automation program is started. A d
tory is formed based on the time/date the program was started on and the
name of the operator who started the program. This directory is used
temporary purposes only and, if the setup is not explicitly saved, it will
deleted when the program exits. The directory resides in XWINNMRHOM
prog/curdir/changer/inmrchanger.

• The main menu bar with pull down menus for Automation operation.
Most of the commands in the commands in this menu may be accessed q
using keyboard accelerators. For example <Alt-f, c> closes the automation
setup window. This is the same as clicking with the mouse on the 
File->Close menubutton. The setup window is designed to be suitable for 
board or mouse interactions at all times. That way you can speedily set up
experiments without having to jump back and forth between keyboard 
mouse operation. See “Using the mouse or the keyboard” on page 5.

• The setup Icon-Bar.
These are buttons exclusively for mouse use to quickly access basic setu
dow features, e.g. Start/Stop Automation, show the sample holder over
show more detailed experiment information etc.

• The experiment display area consisting of a hierarchical listbox of experi-
ment entries
Hierarchical simply describes the way in which the three levels of informa
shown in the listbox are stacked above each other. At the top are the s
holders, then come the experiments followed by any reference experi
information, Figure 4.1 Holder 11 is at the top or the hierarchy. It has 2 ex
ments (shown by the type icon). These 2 experiments are lower down i
hierarchy, they belong to holder 11, the COSY experiment having a refer
spectrum information line which is at the bottom of the hierarchy, it belong
the COSY experiment. Double clicking on a list entry folds it up or down
reveal information already entered or entry boxes for addition of further exp
ments.
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• The experiment queue control buttons
The buttons in the center of the setup window always apply to selected en
(marked in blue) in the experiment listbox area. Use them to submit ex
ments to the queue, remove experiments from the queue, edit previously
celled experiments, delete experiments or for addition/copying of experim
information. Their operation will be described in detail later.

• A history box showing details of all experiments performed

Here you’ll find detailed information on completed experiments no longer in
queue. The 400 most recently performed experiments will appear here. The
ous stages of acquisition are shown; tuning/matching, rotation, lock, shim, acq
tion and processing. Successfully completed stages are shown with a tick wh
stages where any problems were encountered are marked in red with a cros
sample change is currently not shown, however, if no ticks or x’s appear
implies that the sample change was unsucessful.

Double clicking on any entry in the history area of ICON-NMR’s setup windo

Figure 4.1 Automation Setup Window
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will cause XWIN-NMR to appear showing the data set which was clicked on.

Note:

More detailed information on what the Instrument actually did may be attained by
using the XWIN-NMR history feature. Ascii files containing all automation com-
mands are then stored in XWINNMRHOME/prog/curdir/<user who started XWIN-
NMR>/history. You may activate this feature via the Display->Status & history-
>On for all data sets menu button in XWIN-NMR.

Once you’ve come to grips with the overall layout of the setup window the 
step is to actually perform some experiments.

4.3 Automation Quick Start Guide

Here you’ll find all you need to know to get the automation up and running a.s

4.3.1 First steps in ICON-NMR Automation

As is the case for Routine Spectroscopy Mode the XWIN-NMR software must be
installed and configured correctly before commencing automation. See “XWIN-
NMR configuration” on page 3 for more details.

To get your first automation run underway proceed as follows:

1. Start ICON-NMR from the Windows->ICON-NMR pull down in XWIN-NMR.

1. Click on the Automation Icon.

2. Identify yourself to the system. If you do not see your user id in the iden
user window, you or the laboratory manager should install a user file using
User Manager form the Configuration Menu. See “The User Manager” o
page 45 for more details.

3. Once you’ve successfully logged in, the Automation setup window sho
appear containing the appropriate number of sample holders. If you se
incorrect number of holders in the setup window in the Holders column t
either:
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a) You have not configured your sample changer correctly, e.g. for BACS do
cfbacs in XWIN-NMR or 

b) You must set the number of default holders using the Configuration Man-
ager. This will be necessary in Manual and Sixpack or Mas automation
modes.

See “Default Number of Sample Holders” on page 64 for more details.

4. Choose the particular holder you’re interested in and

a) Double click with the left mouse button on the holder or

b) Click on the holder and use the Add button <Alt - a>.

5. Once you’ve set the experiment details, go ahead and Submit it.
After an experiment has been submitted you should no longer make mod
tions to it. Should you wish to change something then you should first Cancel
the experiment, then Edit it and finally Submit it again. The safe way to chang
parameters on an experiment is first to Cancel the experiment, use the particu
lar parameter editor and Submit the experiment again.

6. You may add further experiments on that sample with the Add button as
required.

7. Click on the Go icon to start the run. The program may also be configure
start the run automatically. See “Configuration Options” on page 49.

4.4 Component Descriptions

4.4.1 The experiment entries

Each sample holder line in the setup window consists of 12 columns of info
tion classified as follows:

1. Holder
A little triangular symbol and number indicate the current holder. The trian
shows whether individual experiments are displayed or not.

2. Type
Shows whether a holder line has any information and if so displays the nu
of experiments defined for that holder. An empty tube icon depicts an em
holder. To add an experiment to an empty holder either

a) Double click on it or
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b) Hit Return on the anchored1 entry.

3. Status
This may be configured to show traffic lights in two different modes or text.
The mode can be changed by using the Configuration user interface. See 
figuration Options” on page 49. The following experiment states are curre
supported:

•Inactive

•Submitted to Queue

•Running

•Completed

•Error

4. Disk
Disk directory where experiment is to be stored. User selectable or defin
form the User Manager See “The Partition Names box” on page 52. The sys-
tem may thus be configured to allocate the disk partition automatically.

5. Name
Name of experiment. This may be entered by the operator or defined to be set
automatically from the User Manager. See “The Sample Names box” 
page 51. The system may thus be configured to allocate the name automati-
cally.

6. Exp No
Experiment number to be used for this entry. This will automatically be allo-
cated to the next free experiment number based on the current user and the disk
and name the user has chosen. If the operator has the Data Set Edit permission
he may allocate the experiment number himself.

7. Solvent
The solvent may be set up here as defined at XWIN-NMR configuration time by
the edsolv command. Changing the solvent for any component experiment of a
holder changes all other solvents for non-submitted experiments automatically.

8. Experiment
Here the operator may choose the experiment from his pre-defined list. This list

1.  This is the entry with a dotted line border. May be moved by mouse clicking on another entry
or by using the keyboard accelerators <Alt + z> for up and <Alt + x> for down.
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is defined with the User Manager. See “The Experiment List box” on page 47
The experiment type, name and comment are given here. There are pre
two types of experiment normal (single) N or n and composite C or c. Lo
case characters imply that the experiment will be forced to run in the low p
ity “night-time” mode. If a composite experiment is chosen then new exp
ment entries will be added as required for all components of the comp
experiment. 

9. Method
This column is only available if the program has been configured to ru
BEST mode. Depending on the chosen solvent the corresponding metho
defined in bestadm Methods will appear in the pulldown menu. This inform
tion used not be sample dependent, but now that the BEST utility has the 
bility of changing solvents the introduction of a solvent specific method, ma
the system even more flexible.

10.Par
This column currently consists of 2 buttons controlling the User Spec
Parameters and the Lock/Shim/ATM settings for the individual probe/exp
ment respectively.
User Specific parameters may be accessed directly from this column, pro
they have been defined for the respective user, see Figure 5.2.1.10. Chan
this window will be copied to all copied entries. If the Modify Lock/Shim/ATM
permission has been set in the User Manager, then the current settings for
Shim as well as the experiment dependent ATM mode may be altered as n
sary.
The Lock options is treated on a holder basis and not on an experiment 
The Shim option may be set up such that it is possible to shim on every ex
ment. For this option set the “Shim the sample” option in the configuration w
dow’s Shimming Controls page to “on every experiment”.

11.Title
The title icon when activated pop’s up a text entry box which may be use
enter a specific title for later plotting. Originator information items (if ac
vated) are also to be entered here. See “The Originator Items Editor
page 54. The title information will automatically be copied to all other exp
ments added on a particular sample. The title icon changes after text has
entered. Use the Set & Copy Title button to force all other title entries (th
on-edit for the current sample) to set their entries to the same values as th
rent title box.
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12.Priority
Users who have this option enabled in their user permissions file may decide to
prioritize certain experiments. Such experiments will then be run before non-
prioritized experiments. The priority will be based on the time of their submis-
sion. Such experiments will either be run after the current experiment is com-
pleted or when all experiments scheduled on the current holder have been
completed. For more details see ’Priority Options’ on page 72. ICON-NMR also
has a Day/Night mode which may be used to ensure that time consuming e
iments are always run at night. Click on the Sun icon and it will toggle 
moon icon, this will classify the experiment as lower (night-time) priority.
Note the day night mode only applies to each experiment. If you want the 
ple to be measured at night you must mark all its experiments as being “n
experiments. If you’d like to run one experiment during the day and anoth
night then simply mark one as day and one as night.

13.Time
The experiment time (estimated acquisition time) is calculated each tim
experiment is submitted and also after any parameter editor has been used
feature may be deactivated to save some processor overhead.

14.User
The user who entered the experiment on the experiment list is denoted in
umn 12. Note: Experiments belonging to other users may not normally be
ied, deleted or altered in any way. If you want to have complete access to 
users experiments, change user to the nmr super user.

4.4.2 Queue Control buttons

You’ll find an array of queue control buttons in the centre of the Setup Window

All of the following buttons apply to the selected holder/experiments. Sele
experiments have a light blue background to distinguish them. If only the hold
selected (no experiment information selected) then the button’s function wi
carried out on all of the experiments in that holder. Of course you can also 
particular experiments. 

• Submit <Alt + s>
Submit generates all data necessary for the experiment, calculates the e
ment time and sets the status of the experiment to ready. If the run is activ
experiment will be found and executed. Submitting an experiment remove
editable boxes and substitutes them with fixed text elements which ma
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longer be edited. You may only submit an experiment if all the required infor-
mation required to start the experiment is available.

• Cancel <Alt + c>
All of the selected experiments will be effectively removed from the que
This button is useful together with the edit button if you want to make chan
to the experiment before run-time. Note you can always re-submit a canc
experiment, the information content will not be removed. The experimen
merely ‘deactivated’.

• Edit <Alt + e>
This button re-inserts the editable boxes on an experiment entry. These
then be edited in the usual manner. Use in conjunction with the cancel butt
change previously submitted experiments.

• Delete <Alt + d>
Removes all experiment information from the display and from the qu
Does not remove any spectral information from the target disk. As mentio
above to remove all experiments on any sample holder mark the sample h
the entry where the holder number is indicated. To remove a single experi
select that experiment only.

• Add <Alt + a>
To add an experiment to a holder with none (empty tube icon) double clic
the holder or use the Enter key (once the holder has the anchor. See “Hit R
on the anchored entry.” on page 32). If the holder already has at least one e
iment use the Add button to create more experiments on that holder. The s
box to the right of the Add button determines the number of experiment lines
be added. These lines will automatically receive a valid disk, name, experi
number and solvent entry. The only information you have to enter is the ex
ment type.

• Copy
There are two methods of copying a holders experiments to another holde
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a) Sequentially
All experiments on a particular holder are copied to the next (empty) N
holders. This is the default method. Proceed by selecting the holder you
wish to copy. Use the spin widget to the right of the Copy button to set the
required number of copies. All experiments will be copied to the next N
holders in the display area. The expno is incremented to the next free expno
which is a multiple of 10. Should you wish to keep the sane experiment
numbers and increment the Name of the experiment; e.g. Jan-19.001, Jan-
19.002 set the Holder->Increment Name menu entry before copying. The
experiment number will, in this case remain constant.

b) Targeted
The anchored holder’s experiments are copied to every other sele
holder. For more information on how to identify the anchored holder 
page 32. This method is automatically selected if more than one holde
been selected (blue background). The anchored holder’s experiment
copied to all other selected holders. The same numbering strategy is ap
as in the sequential case.

When the copy routine gets to the end of the setup window the cop
wrapped around to the beginning of the table.

• Change User

Click on this icon should you wish to login/logoff the system. The login user de
mines what experiments and environment the operator will have. The border 
of this icon turns red when no user is currently logged in. You may also use
Icon to lock ICON-NMR. When ICON-NMR is in the locked mode no changes may 
made to the current setup. It is also impossible to leave the program. If you wa
alter Experiments entered by other users login as the NMR super user.

4.4.3 Setup Window Icon Bar

The following icons appear under the menu bar and may be used to access p
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lar features with the mouse.

The Automation ‘Go’ button

This button is responsible for starting the run. It has the same effect as the 
Run->New Run menu command. Once activated a popup dialog will appear as
shown in Figure 4.2.

The Initialize Run Dialog is displayed each time the run is started, unless the Lab-
oratory manager has configured the system to start the run automatically at start up
time. See “Automation Driver Engine” on page 65.

The Acquisition Type field refers to the type of sample changer Driver which is
be used in the system, BACS, Sixpack, MAS or Manual mode (no sam
changer). These drivers are TCL/TK scripts and may be adapted to suit your
environment. You’ll find them in:

XWINNMRHOME/prog/tcl/libtix/iconnmr/inmrlib/Automation/driver_lib

Drivers

Driver files have the extension .drv, there’s also a file drivers which is used to tie a
comment to a particular driver file. This comments appear in the Initialize 
window.

The First Sample entry tells the system where to start, i.e. which holder will be 
first. With the ‘First sample in the magnet (locked and shimmed)’ it’s possible to

Figure 4.2 Initialize Run Dialog
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tell the system to skip the locking and shimming routines for the first sample.

As a further option you may instruct ICON-NMR to skip the processing on all the
experiments it performs. This question may be deactivated from the ICON-NMR

Configuration window.

The Automation ‘Pause’ button

Use this button to pause the acquisition. This action will take effect after the cur-
rent running experiment has been completed.

The Automation ‘Play’ button

As you might expect, the play button sets the Run in motion again.

The Automation ‘Stop’ button

This cancels the current run. It will also stop the currently running experiment. If
you wish to stop the run without interfering with the currently running experiment
use the pause button instead. All experiments which have not yet been completed
remain in the queue and are still available for running at a later date. The Stop per-
mission is user specific, only the user who started the run or the NMR Super user
(password required) may stop it.

The Sample Holder Overview
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Use this button to call up the window shown in Figure 4.3. This window lets you
see at a glance what the sample changer has been up to during the automation. It
shows all sample holders in a grid array. As in the history list if an error occurs on
any sample a cross appears in that particular holder.

The sample holder overview may also be used to position the setup display at a
particular entry. Just click on the holder you’re interested in. You can even ope
entry on a previously unused holder by double clicking on it. You’ll also no
that holders in the overview status may be selected in the same way as the h
in the setup window. Click on the first holder you wish to mark and drag 
mouse. All following sample holders will be selected (marked in blue) in both
overview and setup window. If you wish to select holders, which are not ma
sequentially (e.g. for a targeted copy), hold down the Ctrl button before clickin
the particular sample holders. Don’t forget to select the ‘source’ holder for the
geted copy as the last element to make sure it’s the anchored entry.

Tidy Display

ICON-NMR makes full use of multiple windows to display as much or as little inf
mation as is required. This can leave your desktop looking rather cluttered
this button to move and resize all windows to a standard setting. This is the s
which was saved last time the program was terminated.

Figure 4.3 Sample Holder Overview 
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Acquisition Controls Window

This button displays the Automation Control window, provided it has been enabled
in the view menu. The button acts as a toggle. If the window is not viewable it will
appear. If the controls window is on the display, pushing this will remove it.

4.5 Menu Bar commands

4.5.1 The File Menu

The file menu contains the following items:

• New

You may start a second experiment setup window and setup further experime
be run at a later date.

• Open

Open reads in a previously saved experiment setup into the current setup wi
The history information is also loaded.

• Save

If you’re going to perform all the experiments again it might be a good idea to 
a copy of all the experiment information stored in the setup. The ‘Save’ button
do this for you. It saves all the data in an ASCII format which can easily
retrieved or modified using any text editor. The save button will save this file in
directory XWINNMRHOME/prog/curdir/changer/<setup directory name>.set

ICON-NMR saves this file automatically for you. See “Automatic Setup F
Save” on page 64.
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• Print (List Setup) 

This prints a copy of the Setup file in an easy to read format on the default pr
On Windows NT the notepad program is used to print the file. Use the Edit-
Font switch to change the font (if necessary).

• Print History File

Prints the history information at the bottom of the setup window to the def
printer. On NT you may have to set the default font for the notepad progra
obtain reasonable results. Should you have problems you can always print th
directly from the prog/curdir/changer/inmrchanger directory.

• Close

Closes the setup window and returns to the Identify User mode.

• Close All

Use the close all when you wish to close several setup windows in one sweep

4.5.2 The Run Menu

These menu items may be used in the same manner as those already desc
section 4.4.3.

4.5.3 The Holder Menu

Selection Menu buttons

Items in the upper half of the holder menu may be used to quickly select se
items at once. For example you may wish to cancel all successfully comp
experiments in one swoop and then delete them. In this case you’d use the
Holder->Select Completed menu option, followed by the Cancel button and Delete
button.

Copy Mode

Here you can decide how ICON-NMR Automation is to copy experiments. Incre-
ment Expno is the default setting and should be optimal for most purposes. H
any number of experiments will be copied. The system checks and automat
allocates sensible experiment numbers, while keeping the current Name setu

The ‘Increment Name’ mode keeps the same current experiment numbers w
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adding numbered extensions to the name to make new unique data names.

4.5.4 View and Find menus

These contain various menu buttons which control which elements of the setup
window are to be shown. You may use them to improve the clarity of all display
information. The find pull down helps you quickly find particular types of entries.
This may be useful if in certain circumstances you have so many entries that you
can’t see the wood for the trees.

4.5.5 Parameter Menu

As in Routine Spectroscopy mode you can use the parameter menu butto
access any of the parameter editors which XWIN-NMR has to offer. If the laboratory
manager has configured the operator so that he/she can execute specific
mands, e.g. lockdisp then these will also appear in the User Specific Commands
pull-down. See “User Specific Parameters/Commands” on page 53. These b
apply to the entries in the setup window which have been selected. 

Note: Should you accidently hit Edit Parameters when multiple experiment en
have been selected which you do not wish to edit/view, you may cancel the o
tion by hitting the Esc key while the keyboard input focus is in the setup windo

4.5.6 Best Menu

This is only present if ICON is running in BEST mode. 

Show BEST Monitor causes the BEST driver to display its debug window sh
ing all commands sent to the Gilson Liquid Handler, replies and other informat

Show provided solvents displays the BEST solvent editor’s provided solv
page, normally accessible from the bestadm XWIN-NMR command. On start-up
BEST may require that you use this window to set the correct port for a spe
solvent or set the solvent for a particular wash rack.

4.6 Automation Window Tips and Tricks

Here are some features of the Automation window which might not otherwis
apparent.
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• To raise XWIN-NMR in any previously measured data set, double click on
corresponding entry in the history (lower) part of the setup window

• Use Ctrl-x and Ctrl-z to move the selection anchor up and down in the setu

• Use Ctrl-Tab to move the focus out of the title window

• You can change the size of individual columns in the setup window by drag
the mouse with the left mouse button depressed on any column header

• The Delete Key deletes marked experiment setup entries

• The Insert key adds an entry at the anchor position

• The Esc (Escape) Key breaks out of any loop action; e.g. Copying, Submi
Deleting multiple entries

4.7 External Setup

The Automation module of ICON-NMR 3.0 may be used in external setup mod
This means that all the submitted entries are inserted into the setup windo
processing without the need for any direct keyboard input to the setup window

The entries are created via an ASCII file which must be copied to the 
XWINNMRHOME/prog/tmp directory. ICON-NMR Automation scans this direc-
tory periodically (once a minute) for new “setup” files. All you need to do is log
to the ICON-NMR Automation software as any valid user. 

This directory should be made writable for all those XWIN-NMR users who will be
starting the run/copying the files, if external setup mode is to be used. The fo
of this file is exactly the same as it was for the set/run Automation routines. 

Here is an excerpt from the XWIN-NMR manual on external setup:

4.7.1 Acquisition parameter setup with extset

Laboratories often employ a centralized sample management, which require
the experiments are not defined locally on the NMR spectrometer with ICON-NMR,
but rather on PCs or a central laboratory computer, from where they must be 
ferred into the spectrometer via the network or via magnetic storage media. ICON-
NMR offers the following means for accomplishing such tasks:
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The experiments for each sample may be defined in a text file in ASCII format,
e.g. on a remote computer. If ICON-NMR should execute such an experiment, the
file must be copied into the directory XWINNMRHOME/prog/tmp/ of the spec-
trometer computer (e.g. using rcp or ftp in an Ethernet network).

ICON-NMR periodically (every 60 seconds) checks the directory XWINNM-
RHOME/prog/tmp/ for new ASCII experiment files. Any new file will automati-
cally be inserted into the desired setup window. The result is the same as if the user
had entered the information directly on the spectrometer.

Once entered into the setup file, the ASCII file is deleted from the temporary direc-
tory XWINNMRHOME/prog/tmp/. It is therefore the user’s responsibility to keep
a backup copy of this file, if at all. If several ASCII experiment files are found by
extset, they are processed in the order of their file name extensions NNN. 

An experiment is defined by the keywords HOLDER, NAME, EXPNO, SOL-
VENT, EXPERIMENT, TITLE. 

They correspond exactly to the fields of the ICON-NMR setup window. NAME,
EXPNO, and TITLE are optional, i.e. they may be omitted. In that case ICON-NMR

uses standard default values: EXPNO=10; no title; NAME is formed from the
name of the experiment file, the extension being replaced by the HOLDER num-
ber. Only experiments of type N (no preparation experiments required) or C (com-
posite experiments) are allowed.

Figure 4.4 illustrates the main Keywords used in ASCII experiment files. Lines
starting with the character # are comment lines, which are ignored. The file con-
sists of a series of keywords (one per line) combined with information. 

Features 
1. No limit to the number of experiments per holder.
2. The first experiment on a holder can be a composite experiment. 
3. Each experiment can have an individual title. Titles can have more than one line.
The line separator is the \n sequence. If several experiments are defined for one
holder, each experiment can have an individual name (NAME) and experiment
number (EXPNO). 

When ICON-NMR sees a new extset file it will normally read all the information in
it and enter the experiments in the setup and submit them. If you do not wish the
created entries to be submitted then you should include the Keyword
NO_SUBMIT in your extset file before the EXPERIMENT keyword line. With the
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Keyword SUBMIT_HOLDER you can submit all experiments for a particular
holder at a later stage. The SUBMIT_HOLDER keyword requires a preceding
HOLDER and EXPERIMENT keyword to be recognized.

There are also new keywords DELETE and PRIORITY which may be used to
delete all experiments for a given holder and to set the Priority flag for a given
experiment respectively.
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# Comment line

USER data set USER parameter

HOLDER Holder number to be used

NAME data set NAME parameter (optional)

EXPNO data set EXPNO parameter (optional)

SOLVENT solvent name

EXPERIMENT experiment name (of type N or C)

METHOD
method name 

e.g. methodname user (for BEST)

TITLE rest of line is the plot title (optional)

DELETE deletes all experiments for a holder

PRIORITY enables the priority flag for this experiment

NO_SUBMIT
the entry will appear in the setup list but 

will not be submitted

SUBMIT_HOLDER
all entries for the defined holder will be 
submitted, no new entries are created

END end of holder definitions section

Figure 4.4 Keywords used in Ext Set files
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The following example ASCII text file summarizes the ext set file features:

# in 1. column means: comment 
USER eng 
HOLDER 8 
# 
NAME June15 
EXPNO 10 
SOLVENT CDCl3 
EXPERIMENT sw_cosy45 
TITLE This is a title\nwith two lines 
TITLE This is a second title for the first exp. of the comp. 
TITLE This is a third title for the second exp. of the comp. 
NAME June16 
EXPERIMENT PROTON 
TITLE This is a title\nwith two lines 
EXPERIMENT C13CPD 
TITLE This is a title\nwith three lines\nThird line 
# 
HOLDER 9 
NAME June17
PRIORITY
SOLVENT CDCl3 
EXPERIMENT PROTON 
TITLE This is a default title 
EXPERIMENT C13CPD 
TITLE This is a default title 
EXPERIMENT C13DEPT45 
TITLE This is a default title
#The next two lines delete all experiments for holder 10
HOLDER 10
DELETE
# Only one END statement per complete file ! 
END
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Chapter 5

Configuration Suite

5.1 Overview

The Configuration Suite (Figure 5.1) is started from the respective icon in the main
mode of ICON-NMR. You may also use the Configuration Suite menu in Routine
Spectroscopy or Automation modes. This window may only be activated if you
know the NMR Super User password or if password checking has been disabled.

Configuration Options

The configuration suite is used to configure all aspects of ICON-NMR. This user
interface is intended to grow with the ICON-NMR program. At the moment the Con-
figuration Manager is divided into 14 pages: User Settings, Additional ICON-
NMR Users, Originator Items, Composite Experiments, Automation Window,
Driver Engine, Automatic Tuning/Matching, Priority, Shimming and General,
Temperature Handling, LC-NMR Options, LIMS Options, Barcode Printing Rou-
tines and General Options. Not all of the configuration options apply to all Auto-
mation modes. For example the Temperature Control options are of no value if you
only have a sixpack sample changer.
49
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5.2 User Settings

5.2.1 User Manager

The User Manager lets you comfortably control just how much freedom the users
of the instrument are going to get. These features apply for the most part to both
the Automation and Routine Spectroscopy parts of the program. Setup one template
for your users and save it for all the users on the system. Update the experiments
which have been cleared for particular users in one sweep. Save user specific
information which can later be used to group particular users with similar informa-
tion together. Custom tailor (for your lab) exactly what information the user must
enter before any experiment may be started (E.g. An Originator ID describing the
probe being measured.) 

Figure 5.1 ICON-NMR Configuration Suite
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Now you can restrict the input to suit your particular file handling needs.

5.2.1.1 The User Names box

When first started the User Manager shows all the workstation user names and
Additional user names which are currently defined for ICON-NMR in the User
Names box (Figure 5.1, upper left). Additional users do not normally need to be
defined. Those users who already have a userfile are shown with a bold font and
have an “enabled” indicator icon.

All items displayed in the various boxes of the User Manager window are valid
the user whose ID is highlighted in the User Names box. Click on the name w
user information you wish to view or change. The respective information is 
loaded from a file and displayed. When you're happy with the settings for a pa
ular user, save the file using the save button.

5.2.1.2 The Experiment List box

This listbox is used to define the experiments a user may perform. The list s
all experiments currently enabled for the user selected in the User Names bo
mode and details of the experiment are shown. Mode defines whether the e
ment may be run anytime (sun) or only at night (moon). Details comprises 
columns show experiment type, name and comment.

The type is encoded into a single character: N denotes a normal (single) experi-
ment and C a composite experiment. A composite experiment is a sequence of n
mal experiments which can be defined in the Composite Experiment Manager. The
member experiments of a sequence may depend on each other. For examp
first experiment of a sequence could be a preparation experiment for a subse
2D experiment. In such cases, the composite experiment manager allows y
specify the reference experiment(s).

5.2.1.3 Setting up the experiment list

To make any changes in this list you must first activate it by clicking on an ent
it or by using standard keyboard traversal (tab key) to activate a particular en

The entry box shown in the center of Figure 5.1 will show the type of experim
you have selected in the list, its name and its comment. Use the following bu
to alter the list:
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• Update User Files
The contents of the respective listbox (Experiment List, Partition Names, 
may be saved directly to several user files, leaving all other information in
respective user files intact. Choose the user files you wish to update from
list shown in Figure 5.2.

• Delete
Remove the marked (=highlighted) experiment(s) from the list. In orde
remove several experiments at once, mark them in the following way: Clic
one of the experiments using the left mouse button. Keep the button depr
and move on to the next line, and so on, until all desired experiments
marked. You can achieve the same effect by marking the first experiment w
mouse click followed by a mouse click on the last experiment while the S
key is held down. If you want to delete several experiments which are not
played on subsequent lines, hold down the Ctrl key while you click on the 
vant experiments.

• Prepend
Use this button to add a new experiment above the currently selected ex
ment. Select the name of the new experiment from the button at the right o
Experiment Name entry. The displayed list is constructed from the parame
sets present in the directory XWINNMRHOME/exp/stan/nmr/par/, and the
defined composite experiments. This means that you can only add an e

Figure 5.2 Update Multiple User Files
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ment to a user’s experiment list if the respective set of acquisition, proces
and plotting parameters already exists. If you did not set up your own ex
ments, Bruker’s standard experiments and standard composite experimen
available, provided XWIN-NMR’s expinstall command was run successfully.
Before you add the experiment to the user’s list, you may change the com
The experiment type is a view-only parameter which can take on the va
Single (Normal) (N) or Composite (C). When you add a new parameter set 
the directory XWINNMRHOME/exp/stan/nmr/par/, it will be assigned type N
by default. If the new parameter set designates an experiment requiring p
ration experiments, you must define a composite experiment in Composite
Experiment Setup mode, which includes the preparation experiments. You 
give the composite experiment the same name as the parameter set: If a
posite experiment and a parameter set use the same name, the name w
appear once in the user’s experiment list, and the executed experiment w
the composite experiment.

• Append
As the name suggests this button adds the information to the list after the
rently highlighted entry. Apart from that, everything said about Prepend entry
is valid.

• Modify
This button allows the information shown in the entry field to be transfer
directly to the currently highlighted line in the listbox.

• EXIT
This button removes the entry box from the top of the window. The entry 
disappears.

You can now change the order in which the experiments will appear in the
specific experiment list by using the right-mouse button to move experim
entries around in the list. First set the focus to the Experiment List (by using th
key), that way you can then grab an entry from the bottom of the list, use the P
key to move the listbox to the top and then release the mouse button to dro
entry. You do not have to set the focus first if you only wish to move an e
around in the currently visible part of the list.

5.2.1.4 The User Permissions panel

This panel is located below the User Names box of Figure 5.1 and allows y
enable or disable certain ICON-NMR features for a user. 
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Priority

A user may declare a sample to be treated as a priority sample. This option is only
meaningful for automation with a sample changer. Use the Configuration window
in the system manager to define how the priority switch is to be handled.

Archive Data
Use this option to copy all the current experiments data to the Archiving Directory
(also entered from the user manager) after processing has been completed on the
current experiment.

Supervisor
If enabled for a user, the next time this user starts ICON-NMR all ICON-NMR win-
dows will get borders and a menu bar, allowing them to be moved or iconified on
the desktop, thus allowing access to other programs without having to terminate
ICON-NMR. This permission will also gives such users full control over XWIN-NMR

to start/stop other processes at will.

Essential Originator
If enabled, the user must fill in the originator entry which appears in the filename
entry box before he can carry on with the setup.

Manual Lock/shim
If enabled, the user may either select manual or automatic locking and shimming.
If disabled, the automatic procedures will be enforced.

Parameter Edit
If enabled, the user may invoke the parameter editing commands from the Param-
eter menu in Routine Spectroscopy or Automation modes and alter the acquisition,
processing, or plotting parameters of an experiment before he starts it.

Exit (Icon-Nmr)
If enabled, the user may terminate ICON-NMR.

Data Set Edit
If enabled, the user may define his own data set filenames. If disabled, he may only
choose from the names provided in the Sample Names box (see below).

Originator
If enabled, the so-called originator information and the associated user specific
information will be included in the filename setup box for Routine Spectroscopy or
in the title window for Automation modes. You set up originator information from



5.2 User Settings 55

” on

 of

ag-

ig-

he
on
le.
edia

ange
e an
n of
ular
him

ation
 “on

 in a
ON-
g/
DONE

INDEX

INDEX

the Managers->Originator Setup menu, and user specific information from the
respective box in the User Manager window. See “The Originator Items Editor
page 60.

Iconbook
If enabled, the user may invoke the command Iconbook from the Options menu of
respective ICON-NMR mode. (SGI only)

Email Notification
If enabled, the operator will receive an email notifying him of the completion
his/her experiment provided:

a) Email is operational on the controlling workstation. (NT Windows mess
ing has been activated)

b) The Target Email Address (also available in the User Manager or as an Or
inator Item) has been setup correctly for the current user.

Data Mail
Data Mail uses the smail XWIN-NMR program to send 1D data on the Internet to t
Target Email Address (if defined). For SGI systems this option is only available 
Workstations where a Zmail (MediaMail or MediaMail Pro) client is availab
You do not need a Software license to use Zmail to send mails. Install the M
Mail software from the IRIX CDs accompanying your workstation.

Edit Lock/Shim/ATM (Automation Mode Only)
Use this permission flag to decide whether the User should be allowed to ch
the default lock/shim/atm settings. When this flag is activated the user will hav
additional menu button, (with a lock signal displayed on it) in the Par colum
the setup window. If multiple experiments have been submitted for a partic
holder position, some of this information may be ignored. For example, if the S
setting is to be considered for each individual experiment then the configur
option “Shim the sample” in the Shimming Controls window should be set to
every experiment” 

JDX Copy

From ICON-NMR 3.0 onwards it’s possible to have ICON-NMR generate a copy of
the data set in JCAMP-DX format and store the data with an unique name
directory as specified by the fields shown under the General Options Tab of IC
NMR’s Configuration Suite. This feature is in addition to all the other Archivin
Data Mail modes.
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5.2.1.5 The Sample Names box

Use this box to define the data set NAMEs you want to propose or prescribe for a
particular spectrometer user. All names defined here will appear in the names list
of the Filename box where the user defines the data set name during experiment
set up. If you enable the Data Set Edit checkbutton (see above), the user may also
enter his own data set name. Otherwise he will be restricted to those you set up
here.

ICON-NMR provides five special names, $DATE, $DATEUSER, $NUMERICDATE,
$USER and $HOLDER. These macros will be expanded when the user opens the
names list in Routine Spectroscopy and Automation modes. You can also make use
of date variables such as %M and %Y etc. to form your own standard data set
names.

Click in the Sample Names box to open the respective edit box at the upper right
corner of the User Manager window. Enter the desired name, $DATE, $NUMER-
ICDATE or $DATEUSER and click on Prepend entry or Append entry to add the
name to the list. Click on Delete entry to remove the currently selected name from
the list. Click on Modify entry to apply changes to the currently selected name.
Update users may be used to save the listbox settings to multiple user files.

5.2.1.6 The Spectrum Number Filename entry

This entry at the bottom of Figure 5.1 provides an additional method of prescribing
data filenames.

The contents of this entry field will be considered as the pathname of a text file
(Example: /usr/adm/spectrumno.txt) set up by the laboratory manager. The file
must hold a name beginning with letters and ending with a number, e.g. H1000 or
C1. This name will appear in the names list of the Filename box where the user
defines the data set name during experiment set up. This particular type of data set
name will automatically be incremented with the next sample. The names in the
above example would then change to H1001 and C2. The incremented name will
be written back to the text file: Should ICON-NMR be terminated and restarted, the
user would still get the next name in sequence for his new experiment, provided he
uses the Eject & Terminate option in the insert sample window. 

For Automation, when this file has been defined, only the name prescribed in the
file will be available to the user.
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5.2.1.7 Target Email Address, Archiving Directory and Umask

These three entries allow the above items to be defined on a per user basis, even
for so-called NMR users who do not have a direct login on the workstation. The
archiving directory could be used for example, to define an NFS mounted filesys-
tem which is to be used to store a copy of any experiments data after processing.
The workstation manager is responsible for the setup of such an archiving direc-
tory.

5.2.1.8 The Partition Names box

Use this box to define the disk partition(s) where data sets acquired by the current
user may be stored (this corresponds to the possible settings of the XWIN-NMR

parameter DU). If you allow for several partitions, all names defined here will
appear in the Filename box where the user defines the data set name during exper-
iment set up.

Click in the Partition Names box to open the respective edit box at the upper left
corner of the User Manager window. Enter the desired partition and click on
Prepend entry or Append entry to add the partition to the list. Click on Delete entry
to remove the currently selected partition from the list. Click on Modify entry to
apply changes to the currently selected partition. Update users may be used to save
the listbox settings to multiple user files.

In Automation mode the parameters are accessed from the Par column button
which is displayed on every active experiment entry line. The Commands may be
accessed from the Parameters pulldown at the top of the setup window.

5.2.1.9 The User Specific Information box

Using “The Originator Items Editor” on page 60, you set up entry items which 
appear in the Filename box (when using Routine Spectroscopy), or in the Ti
window (when using Automation) where the user enters the data set name f
experiment. The corresponding entry fields (e.g. Department, Costing Group, or
whatever you have defined) will remain empty, and the user must enter a su
item, e.g. a department number. In some cases the item to be filled in is kno
advance, and the user should not need to type it in (e.g. his e-mail address). 

Click in the User Specific Information box to open the respective edit box at
upper right corner of the User Manager window. Select the desired item (w
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you have previously defined via the Originator Item Editor) from the User Infor-
mation Type pull down menu of this box (e.g. the item Mail Data/Noify to). Enter
the respective user data (e.g. the user’s e-mail address) into the User Information
Data entry. If the data changes from experiment to experiment then you sh
leave the Originator data field empty. The user can fill it in at experiment se
time.

Click on Prepend entry or Append entry to add the information to the list. Click on
Delete entry to remove the currently selected information from the list. Click 
Modify entry to apply changes to the currently selected information. Update users
may be used to save the listbox settings to multiple user files.

5.2.1.10 User Specific Parameters/Commands

Here the laboratory manager may define the names of parameters or com
which the specified user is allowed to change or run. The Parameter Edit pe
sion does not have to be enabled to allow this type of parameter editing. 

As an example, if the user should only be allowed to alter the TD parameter the
the Parameter Edit checkbutton should be de-activated and the entry td adde
the user specific parameters/commands list. 

Note that XWIN-NMR commands may also be entered in this box allowing us
with no “Supervisor” permission to access specific XWIN-NMR commands. In
Automation, where possible the command will be run on the appropriate c
sponding acquired data set.

You may configure entries from this list in the same manner as described abo
the Partition Names box.

5.2.1.11 The Delete, Default, and Save buttons

The respective commands are also accessible via the File menu. The Save button
saves the current settings on disk, in the file

XWINNNMRHOME/conf/instr/<instrument-name>/inmrusers/<userid>

The Default button initializes all boxes with the default information stored in t
file

XWINNMRHOME/exp/stan/nmr/lists/sam_users_exam.inmr
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You may save everything you have set up so far for several users at once. Hold
down the CTLR key and mark all desired users in the User Names box by clicking
on them. Or keep the Shift key depressed while clicking on a user. This will auto-
matically mark all users from the currently selected one to this position. Then click
on the Save button.

Due to popular demand a Delete button has been added to remove users from
ICON-NMR! Mark the users you wish to delete and click on the delete button.
Their user file will be deleted.

Note:

With XWIN-NMR 2.5 you can use the AU program runproc to run batch processing
commands on data sets which have been acquired by ICON-NMR Automation. The
program uses the history files which ICON saves automatically to retrieve the
names and paths to the data sets acquired during any given run. You may select all
data sets for reprocessing or choose only the ones you are interested in. Use the
xaup command to reprocess. If you haven’t compiled the runproc program already,
you will need to type xau runproc on the XWIN-NMR command line, to use the pro
gram.

Tip: You may also re-run the processing in ICON-NMR Automation by submitt
the experiments to be re-run and starting the Automation using the “Proce
Only” Automation driver.

5.2.2 The Additional Users page (was NMR User Manager)

Additional Users are Spectrometer Users who do not have a Unix user accou
the workstation managing the spectrometer. They may, however, still per
experiments and the experiment information fids etc. will be stored using the N
effective users ID and permission as defined. Additional Users is an extra fe
available only in ICON-NMR. These users must not be defined for normal operat

All Additional Users may have their own password and may initialize or res
once they have logged into the ICON-NMR system.

Additional User names and the respective abbreviations used for their name
shown in the listbox above the command box. You may modify this list using
Delete, Append, and Modify buttons shown next to it. The Append entry bu
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acts relative to the highlighted position.

The NMR Super User is the name of the privileged user whose password (pro-
vided one exists), must be entered before carrying out potentially sensitive tasks.
This information is defined when XWIN-NMR is installed. It should normally not be
necessary to change this. Should you wish to change the NMR Super User then
please use the installnmr script in XWINNMRHOME/prog/bin.

Each Additional User name entered here also appears in the main User Manager
Window User Names list box. User specific information may the be set up there.

5.2.3 The Originator Items Editor

The Originator Items Editor lets you edit the list of items which may be entered in
the Routine Spectroscopy Filename window or the title entry in Automation mode,
when an experiment is being setup. Each entry in the list box created here will
appear in the Filename or Title window along with an entry box where the corre-
sponding information is to be entered (provided the Originator checkbutton for the
particular user has been activated). 

Use the types pulldown menu or make new Originator types using the entry box
and the append button. The Append entry button acts relative to the highlighted
entry’s position.

Use the User Manager window to decide on a per user basis whether the add
entry boxes will appear at all (Originator Checkbutton) and whether the informa
tion must be entered before the experiment may be submitted and started (E
tial Originator). Default values on a per user basis may be entered in the
specific information box in the User Manager.

5.2.3.1 Automation Mode Options

ICON-NMR 3.0 has new options to control originator handling more flexibly. W
“Generate orig file in Data Set” you can control whether an “orig” file contain
the originator information, will be saved in the data set. “Include Originator I
field in orig/title file” determines whether the Item Names will appear in the t
file or Orig file. “Insert this text between Originator Items” can be used to con
exactly how the originator information will be formatted.



5.3 Composite Experiments 61

”.
s for

with a
email
setting
ss has
mail

tifica-
tifi-
t (if

direc-

ment
ould

mpos-
isting
fy the
execu-
nts are
osite

ld be
 the

xperi-
DONE

INDEX

INDEX

ICON-NMR 3.0 provides a special Originator Item called “Mail Data/Notify to
This entry may be used in the Automation mode to override the email addres
the current user as set up in the user manager. This is useful for installations 
large number of users where only one user configuration is being used. If an 
address is entered here then it will override the User Manager email address 
for the user. If there is no email address for the current user and no addre
been entered in Automation mode at the respective Title entry field, then no e
will be sent. This way you can decide on a per experiment basis when a no
tion/data e-mail will be sent. Note that the Email Notification and Data Mail no
cation flags for the particular user determine what type of e-mail will be sen
any).

5.3 Composite Experiments

Experiments that may be executed by a user from ICON-NMR are stored in form of
parameter sets (i.e. acquisition, processing, and plot parameter files) in the 
tory

XWINNMRHOME/exp/stan/nmr/par/.

Bruker experiments are installed in this directory by the expinstall command in
XWIN-NMR. The laboratory manager may add new parameter sets. An experi
name is the name of a parameter set directory, e.g. the COSY experiment w
fetch the required parameters from the parameter files from the directory

XWINNMRHOME/exp/stan/nmr/par/COSY/.

A composite experiment is a sequence of several such experiments. In the co
ite experiment manager you define new composite experiments or alter ex
ones. You assign a name to a new composite experiment, and you speci
names of the experiments that should be included, and the sequence of their 
tion. When a spectrometer user selects a composite experiment, all compone
executed automatically. Composite experiments may not include other comp
experiments.

In ICON-NMR, any experiment requiring preparation experiments must be set up as
a composite experiment. For example, a sweep width optimized Cosy wou
defined as a composite experiment consisting of a suitable 1D, followed by
actual 2D experiment. A preparation experiment is designated reference e
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ment within ICON-NMR.

5.3.1 Defining experiments

In order to define a new or alter an existing composite experiment, click on the
“Add new” button at the base of the manager window.

Apply your changes in the Composite Experiment Editor window shown in Fig
5.3 or enter a new name and a comment. Click on the Modify button to make the
modification effective, or click on Prepend or Append to add the new experimen
to the list.

Click on the Experiment Name button and select the first experiment of the com
posite experiment and append it using the Append button. Carry on in this way
adding other experiments to the composite experiments. If an experiment you
to append requires one or two reference experiments, use the F2 Reference and F1
Reference buttons to select them. When you click on these buttons, all experim
which are already part of the composite experiments will be displayed along
their sequence label (a, b, c, ...), and you can choose which ones should se
references.

5.3.2 The ‘Save to’ button

After a new composite experiment has been defined you may wish to ‘save’ i
particular users user file, thus bypassing the User Manager page.

Mark the composite experiment(s) you wish to save and click on the ‘Save to’
ton. A list of the users who currently have a user file is shown. Mark the partic
users who are to use the newly defined composite experiment and use the ‘S
selected users’ button.

The marked composite experiment(s) will be appended to the start of the re
tive users experiment list.

5.3.3 The Default, Revert and Save buttons

The Save button saves the current settings on disk, in the file:

XWINNMRHOME/conf/instr/<instrument-name>/inmrusers/.pool_txt.

The Default button initializes all boxes with the default information stored in t
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file:

XWINNMRHOME/exp/stan/nmr/lists/def_comp_exps.inmr.

The Revert button reloads the last saved settings from the inmrusers/.pool_txt file.

Figure 5.3 Composite Experiment Editor

5.4 Automation Window

The Automation Window page currently contains the following options:

• Holder Status Display Style
Here you’ll find two different status ‘traffic light’ styles, North American an
European, plus a spell-it out text only mode. There is also a new Bruker 
dard Style which should increase the conformity between Bruker’s var
Automation Software programs.

• Touch Screen Compatibility Mode (NT Only)
This check button puts the ICON-NMR Routine Spectroscopy and Automa
modes programs into Touch Screen mode. All ComboBox style input wid
switch to a large icon mode which may be easily be accessed with your fi
Title input/Parameter Input windows get a “virtual keyboard/keypad” elimin
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ing the need for Keyboard and mouse! This mode is currently only available on
Windows NT workstations.

• Default Number of Sample Holders

The number of samples to be shown in the experiment manager window can
here. 

• Automatic Experiment acquisition time calculation

Every time an experiment is submitted the experiment time as calculated b
XWIN-NMR expt command will be shown. This calculation is done once per exp
iment type and in cases where the parameters have been changed.

• Logout Idle users Automatically
In an open access environment, operators should be required to log them
out after they have submitted all their experiments to be run. They may, 
this option be logged-out automatically after a certain amount of ‘Idle time’ 
elapsed. After this period of inactivity the Identify User window will re-appe
and the experiment manager window will be disabled. It is, however, still po
ble to observe what the Instrument is doing. Use the Logout Delay to adjus
required idle time.

• Enable Automation Controls Window

This flag determines whether a control panel similar to that shown in Figure 3
page 23 will be shown during an automation run. This feature may be disabl
prevent users from (for example) processing the data.

• Automatic Setup File Save

This flag will cause the contents of the setup window to be automatically sav
regular intervals. Should anything go wrong, this file may be loaded later to re
the setup.

The ASCII file will be saved in
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XWINNMRHOME/prog/curdir/changer/<setup dir name>.set and may be read
using the File->Open menu in the Setup Window.

• Approx. overhead time for sample change (secs)

ICON-NMR calculates the time required for the acquisition in order to know h
long the instrument will be busy. With this window you can define just how m
time ICON should allow for the sample changing/locking shimming etc. when 
culating the total busy time.

• HTML History File

ICON-NMR 2.0 can save all the information stored in the history list in HTML for-
mat. This entry is used to define where ICON saves this file. It’s a good ide
make sure that everyone can write to this file. If this file is located in a direc
which is supported by a HTML server the History may then be observed remo
over the net. IRIX 6.3 has a directory ~/public_html which makes its contents 
licly accessible from the net.

Note the automatic history file is stored with a .hist extension with the same n
as the setup directory itself i.e. in XWINNMRHOME/prog/curdir/changer/inm
changer/<setup directory name>.hist

5.5 Automation Driver Engine

5.5.1 Master Switches

These options apply to the Automation part of ICON-NMR only. The “Driver” is
responsible for all spectrometer control commands which ICON-NMR issues to per-
form experiments. As such it is ICON’s engine. 

For more information on drivers see ’Drivers’ on page 37.

• Start run at User Login

Normally the run must be started manually after starting the Automation part of
ICON-NMR. This means that operators who forget to do this, will submit th
experiments for execution and leave the instrument, to do the work which it
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never see. To get around this potential problem the Run may be started using this
function automatically. When this mode has been activated you must also define
which driver is to be started automatically. Use the Default Automation Mode to
define this.

• Default Automation Mode

You only need to specify the default automation mode if automatic run has 
specified. It informs the run interface which driver to use. For more information
drivers see ’Drivers’ on page 37.

• Eject Last Sample in queue

When this check button has been activated the sample changer will also eje
last sample which has been measured, after all other submitted samples hav
measured. Some automation modes do this regardless of the setting e.g. 
HRMAS.

• Process Data Sets after Acquisition

Possible settings include ‘Always’, ‘Never’ or ‘Ask on Start-up’. When using A
on Start-up a checkbutton will be displayed in the window which appears 
clicking on the ‘Go’ button.

• Delete temporary Data Sets after experiment end

With this option activated some disk space will be saved during the run. How
if you wish to retain modified parameter information in it is better to leave 
option off. Otherwise modified parameters may be lost should you wish to re
mit a completed experiment. 

Temporary data sets will be removed by ICON on exiting if you do not save
setup. Icon uses the temporary data sets to store changed parameters, sa
when using the Copy function and for other reasons. The data sets are stored

XWINNMRHOME/prog/curdir/changer/inmrchanger/MonthDay-Year-Time-use

The date information is obtained from the system when the setup window is
opened.
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• Automatic Lock Program

Here you may define exactly what ICON’s driver does when trying to lock. W
the Skip option you can tell ICON to skip locking altogether e.g. lock extern
from the acquisition AU program, or just run a few samples without the lock.

The default value for this setting is: 

LOCK #Default

You can enter any XWIN-NMR command here, including AU programs macros 
commands you would normally enter on the command line. The CPR_exec_
macro command tells XWIN-NMR to execute the following and wait for the com
mand to finish. You must always include this to execute your command. 

If you want an AU program to be executed and ICON to wait until the AU p
gram is finished then you should use the XAU macro, instead of 
CPR_exec_wait macro:

XAU auprogram args

where auprogram is the name of your AU program and args are any argumen
may wish to forward it.

Should you wish the command to be executed in the background (without wa
for completion) use the command CPR_exec 

Multiple commands may also be entered, each command should be separate
“;”. The “#” signifies that a comment follows.

Delays may also be included before or after a command if required. To wai
seconds before locking include the following text before the CPR_exec_
macro:

after 60000;

If you’re familiar with TCL the tool command language from John Ousterho
feel free to enter TCL commands here too!

• Lock only after a solvent change

Should ICON only try to lock when the solvent has changed, activate this 
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This feature is only available in Automation mode.

• Ignore the XWIN-NMR Prosol Parameters

This is a useful feature which tells ICON-NMR not to update the parameters whic
are usually controlled over the edprosol interface. That way you can be certa
you save your parameter set with wpar ParameterSetName all, that you will a
be able to reproduce the experiments under exactly the same conditions.

• Never Rotate the Sample

This may be interesting for some users who wish to disable sample rotation 
pletely without having to edit the acquisition parameters (RO) of all parameter
used in Automation.

• BEST Mode Settings

Here you may switch ICON into BEST (Bruker Efficient Sample Transfer) mod
Leave this option off unless you have purchased BEST! BEST uses a flow i
tion technique to boost sample throughput to the limit. In BEST mode there
various configuration options possible via the bestadm commands. These are
accessible from the BEST Administration Tool button.

• Use Barcode Reader for Best

When ICON is running in BEST mode a barcode reader may be added to th
son liquid-handler which works in conjunction with SampleTrack, Brukers La
ratory Information Management System to fully automate Sample preparation
experiment submission. In this mode ICON receives all of its input directly f
the Bruker’s SampleTrack software.

5.6 Shimming

ICON-NMR 3.0 has lots of features to help you optimize your Automation run to
limit.
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5.6.1 Shimming Controls

• Automatic Shim Program

Use this to decide which type of shimming you’ll be using. ICON-NMR provides 3
default options:

Default 

TUNESX

Shim based on the probe/solvent dependent tune file saved when you set
system using edprosol XWIN-NMR commands.

GRADSHIM

Use the gradient shimming automation program to greatly increase the shim
performance (you need gradients installed on your spectrometer).

Skip Shimming

Use this mode when shimming is not required, or where the shim control is 
dled externally, (e.g. by the Acquisition AU program see the AUNM paramete

You may of course enter your own command here. For simplex shimming (
your own tune file) You could enter a command like: 

CPR_exec_wait tune mytunefile

The mytunefile can be generated using the edtune XWIN-NMR command. You’ll
find example tune files in: 

XWINNMRHOME/exp/stan/nmr/lists/group

Delays may also be included before or after a command if required. To wai
seconds before locking include the following text before the CPR_exec_
macro:

after 60000;

The argument to the TCL after command is in milliseconds.
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If you’re familiar with TCL the tool command language from John Ousterho
feel free to enter TCL commands here too! See “Automatic Lock Program
page 67.

• Shim the sample
Specify how intensively the shim routine is to be called.

• Maximum Shim time per iteration
Here you can indirectly specify just how long the shimming part of the auto
tion will run. This limit applies to each gradient as defined in the tune file. If
time limit is exceeded on any iteration then that gradient is skipped and the
gradient started. If the time limit is exceeded at any stage ICON-NMR will mark
the shimming as failed, but the experiment will still be performed.

• Total Time allocated for tune command (minutes)
To ensure that the length of time taken for shimming remains manage
regardless of how many iterations are performed, set this field according
XWIN-NMR is still shimming after this time has expired the automatic sh
routine will be halted and the experiment acquisition will commence.

Note:

From ICON-NMR 3.0 onwards, you may control exactly what ICON does whe
gets to the lock or shim stage in Automation on a per sample basis. For this fe
to work you must first enable the Edit Lock/Shim/ATM permission on a per u
basis.

5.6.2 Automatic Shim File Loading

ICON-NMR has facilities to load a particular standard shim file in Routine Spectros-
copy and Automation modes. The shim files are loaded automatically each tim
new sample has been inserted into the magnet, before the system reaches t
stage. That way it is always ensured that the system is in a well defined sta
each new operator/sample. The shim files will be linked to the solvent and
probe being used.

This window consists of a list of file entries (one for each solvent). The file en
apply to the probe which is shown in the Current Probe Type box. The entries are
self explanatory, see Figure 5.4.

• Lock using -noauto flag
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This option should be used sparingly! For some solvents with several strong peaks,
the lock program may lock on the wrong one. The lock -noauto flag will cause the
lock program to lock on that peak nearest to the field value stored in the /conf/
instr/<spectrometer>/2Hlock file for the particular solvent. The command ’lock -
noauto’ is used instead of the standard ’lock -acqu’ for these solvents.

5.7 Automatic Tuning/Matching 

Some of the latest probes are equipped with tiny motors so that their tuning and
matching characteristics may be varied under software control. The XWIN-NMR

command atma tunes and matches the probe automatically according to the NUC
settings in the current data set. ICON can, if required, run this program automati-
cally. 

The ATM setup page contains the Enable ATM Optimization flag used to globally
enable/disable all ATM activity. Apart from that it also contains a list where

Figure 5.4 Default Shim Files Setup
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matching and tuning may be enabled and disabled on a per experiment basis. You
can either use the copy button at the top right of the page to change elements of the
selected experiments, or use the right mouse button when over an entry to get a
popup menu whereby the underlying entry may be changed.

Possible settings include “Always”, “Never” and “after a solvent change” for b
H and X channels respectively. 

Note: Users may be granted permission to edit the ATM setting for any experim
when logged into the Automation set-up mode. The Edit Lock/Shim/ATM perm
sion in the user manager is responsible for this feature.

5.8 Priority Options

These options only apply to the Automation part of ICON-NMR.

• Enable Priority

Here you may globally disable priority handling, including Day/Night check
altogether. This will speed up ICON’s search for the next sample. If you don’t 
on having priority samples then leave this option off.

5.8.1 Strategy

These options determine (in general) how priority requests will be handled.

• Modes accounted for

Determine what levels of Priority you wish to cater for. Options include Nigh
Day, Priority Only, Priority and Night & Day.

• Priority Sample Handling

Decide whether ICON should jump to a priority sample immediately. This is 
hardware/time unfriendly setting as the sample changer will move to a priory 
ple even if more experiments are queued for the current sample. The default
the sample holder only to be changed to the priority sample after all experim
have been completed on the current holder. This saves unnecessary wear 
sample changer as well as system overhead (i.e. the uncompleted experime
the currently active holder will have to be locked and shimmed again!).
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5.8.2 Night Day Switch-over

Set the times used for night-time experiments. You can also specify whether night
time experiments should be allowed to run during idle Day time.

5.9 LC-NMR Options / Sample Track Options

For further information on these settings see the LCNMR and Sample Track Man-
uals respectively.

5.10 Temperature Handling

ICON-NMR has features to set and check the temperature before and after sample
insertion.

This system is currently only available to customers using a BACS sample
changer, and those who are changing their samples manually. Provision is made
for checking and controlling the temperature both before and after sample inser-
tion. You can set a fixed temperature or use the temperature setting according to
the TE parameter set parameter. The TESET macro sets the temperature while the
TEREADY macro requires 2 arguments. The first defines the maximum time
ICON should wait for the temperature to be reached. The second parameter deter-
mines to what degree of accuracy the program should require temperature con-
formance to the desired value. Once the accuracy has been attained the
Automation can proceed.

For VT experiments in Automation it’s a good idea to define TE as a user spe
parameter. That way you can access the TE value quickly from the experimen
inition line.

5.11 General Options

• Archiving Copy User (Unix only)

If root access on the workstation is allowed, directories will be generated w
needed. If you use the normal user action, ICON-NMR may not be able to copy the
data if the directory structure does not already exist.
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• Include Originator Information in Title

Normally the originator information will be stored in the title file. Use this opti
to disable this feature. Originator Info will in any case be stored in the data s
the file “orig”. For more information on Originator Entries see ’The Origina
Items Editor’ on page 54.

• Experiment Number Automatic Increment

Normally a space of 10 experiment numbers will be left for additional experim
on any given sample. Use this dialog to change this

• Flash Entry Zones

This applies to Routine Spectroscopy only. The blinking frames red and gree
frames may be deactivated using this checkbox option.

• ICON Color Palette

Some other programs may not be able to get their default colors when ICON is run-
ning. Use this option to reduce the number of colors requested by ICON. This may
alleviate the problems in other programs as more colors will be available for t
You may even run ICON in black and white mode, for that great 50’s black a
white movie feeling!

• Password Checking

For those of you working in a trustworthy environment, use this menu to sla
the password checking mechanism in ICON-NMR 2.0. You may disable checking
altogether, or reduce password checking to Manager Items and start-up wi
‘Sensitive Tasks Only’ option.

• Automation Error Handling

This new feature available only in Automation mode allows for even more Ins
ment supervision. If one of the systems being used in Automation fails comple
for example the lock, then the complete Automation Run may be stopped aut
ically. Optionally you may choose to allow the run to continue and should 
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enter a valid E-mail address in the space provided, a notification Mail informing of
the error will be sent to the given address. Multiple addresses may be separated by
semicolons.

This feature is especially useful in BEST mode where invalid results may not nec-
essarily be corrected by running a second time (insufficient sample).

• JDX Copy Mode 

From ICON-NMR 3.0 onwards, ICON will generate JCAMP-DX files automatica
at the end of the measurement/processing and copy them to the directory 
may be entered here. It is also possible to define which filename will be use
the file. Use the File Naming format to decide how the files are to be called. C
on the pulldown menu to see some examples. The Keywords $DATASETNA
and $EXPNO are available in both Routine Spectroscopy and Automation mo

If processing has been disabled, then only the fid may be converted. All o
modes will be ignored.
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 the
Chapter 6

The Accounting Manager

6.1 Introduction

The accounting software is started from the Accounting icon in System Manager
mode. It gathers the information required to calculate prices for spectrometer
usage from an accounting file. The structure of an accounting file has already been
discussed in the Routine Spectroscopy section of this manual. Each time an experi-
ment is executed under control of ICON-NMR, the standard accounting file:

XWINNMRHOME/conf/instr/<instrument name>/inmrusers/Inmracct.brief

is updated.

At start up time the accounting program collects and sorts all user information
stored in this file. Depending on its size (which can grow significantly during e.g. a
month’s period), you will have to wait some time until the dialog box similar to
one shown in Figure 6.1 appears.
77
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Figure 6.1 Accounting dialog box
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6.2 The File menu

The following commands are available:

Open accounting file
By default, Inmracct.brief is the standard file responsible for all accounting infor-
mation. However, the accounting information search can also be performed on
other files with the extension .brief. The open command will display all files of
this type stored in the directory XWINNMRHOME/conf/instr/<instrument name>/
inmrusers/. Select the one you wish to use for accounting. Its name will be dis-
played in the header bar of the dialog box. After you have chosen a new file the
accounting information is collected and sorted. This process may take some time,
so please be patient.

Exit
Terminate the accounting program.

6.3 The Report menu

The following commands are available:

Display on screen
Re-display the report generated via the Start button.

Print
Print the report generated via the Start button on the current printer.

Save as
Store the report generated via the Start button in the specified file. If the file 
name does not begin with a “/“ character, the report will be stored in the login
user’s home directory.

6.4 The Accounting for box

In this box, you enter the users or the department etc. for which you want to g
ate an accounting report. The accounting mode is also selectable.

• Enabling the User button will instruct the accounting software to generate
report for the user which you may select from a list. Click on the down ar
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button to the right of the User button to display the list. This list is determined
at startup time from the standard accounting file, or from the file you have cho-
sen via the Open command in the File menu. The special list entry All will com-
pile a report for all users present in the list.

• The Group button is similar to the previous User item, however, accounting is
performed for the specified Unix group. The special list entry All will compile a
report for all groups present in the list.

• Enabling the Originator button provides the most flexible accounting meth
in the per Experiment mode. Click on the down arrow button to get the list o
originator items displayed that you have set up with the Originator Template
Editor, and select one of them (e.g. Department). Enter the suitable accounting
criterion into the field to the right of it (e.g. a department identifier).

Example 1:
Assume you have selected the accounting type Department. The item Depart-
ment is member of the list because you have defined it as originator item 
the Originator Template Editor. Assume further that in your organizatio
departments are identified by numbers. In order to generate the accou
report for the department 8009, enter this number as the accounting crite
As a result you will get the total sum of spectrometer usage for all users be
ing to this department.

Example 2:
Assume you have selected the accounting type Email Address. The item Email
Address is member of the list because you have defined it as originator 
with the Originator Template Editor. Assume further your email addresses ha
the general form user@organisation.country. In order to generate the accoun
ing report for all users belonging to organization, enter the text @organization
as the accounting criterion. Accounting would then be performed for all u
of organization, also for different country extensions.

This example indicates that the accounting program applies a slightly diffe
identification method to alphanumeric text as compared to plain number
the first case substring matching is employed, while numbers must be ma
exactly.

• Setting the per Experiment mode will instruct the accounting software t
account the time between the start and end of an experiment.
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Setting the mode per Login will instruct the accounting software to compute the
accounting information based on the time between Login and Logout.

6.5 The Accounting Period and Unit Prices 

Please fill in the date of the first and last day of the accounting period (the
sequence is month, day, year). If you want to charge night time rates specify the
start and end time. Otherwise set the time of night start and end to 0, in this case
the accounting program requires less calculation time. Then fill in unit prices that
you intend to charge to the spectrometer users: A unit price per hour of spectrome-
ter usage and a unit price per megabyte disk storage consumed during the account-
ing period. The total is calculated according to

number of hours of spectrometer usage (day) * unit price per hour (day) +
number of hours of spectrometer usage (night) * unit price per hour (night)
+
number of Megabytes consumed * unit price per MByte

If you don’t want to charge for the disk space, set the unit price per MByte to 

You can also enter a currency. The program will append it to all prices printe
the report, but will not perform any calculations with it. You can select the 
rency from a list. If you don’t find that of your country, you may add it to the fil

/u/prog/<version>/curdir/<user>/.currency

Next time you enter the accounting software, your own currency will be inclu
in the list. You may also delete unwanted items from this file.

6.6 The Start button

The program will start accounting according to the parameters you have de
during the previous steps, and display the report. Figure 6.2 shows a typical 
including the performed experiments. The number close to each experiment 
indicates the number of times this type of experiment was executed durin
accounting period. The report also lists incomplete experiments which have 
started but were interrupted either by the operator or because of an error situ
Failed experiments are not included in the price calculation. 
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Accounting File: /usr/adm/Inmracct.brief
Accounting mode: per Login

User: guest
Accounting Period:  from 01/01/96 to 01/31/96

Spectrometer time (day): 5 h 15 min
Spectrometer time (night): 0 h 31 min

Disk Space total: 2.81543 MByte
Unit Price per hour (day): 25 US$
Unit Price per hour (night): 10 US$

Night time:  from 17:00 to 7:00
Unit Price per 1 MByte disk space: 10 US$

Number of experiments: 51
List of experiments:

7 x PROTON
11 x PROTON128
5 x PROTONEXP

28 x PROTONNREXP
Please note: Incomplete experiments:

2 x PROTON

Item price time: 131.35 US$
Item price disk: 28.15 US$
Total price:  159.50 US$

Figure 6.2 Accounting report example



Chapter 7

Journey through ICON-NMR 
Setup

7.1 Introduction

This chapter is intended to guide you, step by step, through the various setup activ-
ities in both XWIN-NMR and ICON-NMR and start you off on your first experiments
in ICON. 

Unfortunately the information here applies to ICON-NMR 2.0 and the figures
shown may bear little resemblance to version 3.0. Also, the prosol handling has
been completely revamped for XWIN 3.0 which renders much of the setup
description obsolete. See the edprosol manual entry in the XWIN-NMR Acquisition
manual. We hope to bring you a new version of this Chapter in the not too distant
future. In the mean time this chapter may still be of some use to help users get an
overall feel for how ICON-NMR works.

Before any experiments can run under ICON-NMR control, XWIN-NMR must be con-
figured to control your spectrometer correctly. If XWIN-NMR has already been con-
figured proceed to “User Manager” on page 127 for more details on ICON-NMR

configuration.
83
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Of course the information given here is system dependent, but it should give rela-
tively new users of Bruker Spectrometers a look behind the scenes at the general
software spectrometer configuration.
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7.2 Software and Hardware Configuration

7.2.1 SUMMARY OF COMMANDS

Configuration:

cf spectrometer configuration

cfbsms BSMS configuration

cfpp installation of printers and plotters

expinstall installation of Bruker standard experiments

7.2.2 LOADING XWINNMR

To load the XWIN-NMR program, follow the instructions in the NMR SOFT-
WARE Release Letters manual.

7.2.3 HARDWARE CONFIGURATION

1. Call in any dataset

2. Type cf 

3. Enter the root password and answer the following questions:

NOTE: The answers below are an example and are suited for a single rack AVANCE
300.

Configuration for spect. Change that? (y/n): n
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What type of spectrometer? (DMX, DRX,DPX): DPX

Basic 1H frequency (with offset O1 = 0 in MHz): 300.13

4. Enter the following RS232 ports for the external devices:

NOTE: Use the default connection listed on the label on the back of the console door.

PREAMP1: tty01

BSMSTY: tty02

RX22TY: tty10

LOCKTY: tty03

5. Click on ‘SAVE’

NOTE: The nuclei table is displayed.
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6. Click on ‘RESTORE’  and then on ‘SAVE’ 

NOTE: The configuration information is displayed on the screen.

7. Click on ‘List’

NOTE: Store the printout of the configuration information with the installation data.

8. Click on ‘OK’ 

7.2.4 SHIM UNIT CONFIGURATION

1. Type cfbsms and answer the following question:

Which device is used for BSMS: tty02

7.2.5 TEMPERATURE CONTROL UNIT CONFIGURATION

1. Type cfte and answer the following question:

Which device is used for VTU: tty05

7.2.6 PLOTTER CONFIGURATION

1. Type cfpp

2. Click on ‘printer-plotter installation’
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3. Click on ‘remove existing printer-plotter’ and enter the root password

4. Click on the printer-plotter name which is displayed and confirm the messa

5. Click on ‘install new printer-plotter’ and enter the root password

6. Click on the printer-plotter name to be installed.

7. Answer the following questions:

Enter identification name: hit the return key

Do you want to specify a class: n

Please enter output device: plp

Install (name of printer-plotter) as default printer? y

Configure (name of printer-plotter) like an existing printer-plotter?n

8. Click on ‘QUIT’

7.2.7 EXPINSTALL

1. Type expinstall

2. Click on ‘OK’

3. Enter the root password

4. Click on ‘proceed’ for default installation

5. Click on ‘select all’ for user permission file

6. Click on OK and answer the following questions:

NOTE: The entries below are an example if the system is connected to an HP Laserjet
4L using 8.5” x 11” paper.
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Enter current printer name: $hplj4l

Enter current plotter name:  hplj4l

Enter paper format: A

Enter digitizer type: (instrument dependent )

Select acquisition mode: qsim or DQD if available

Enter default pre-scan-delay DE: 6

NOTE: expinstall starts now. This process will take approximately 1/2 hour.

7.2.8 CONFIGURATION  OF THE AUTOMATION

7.2.8.1 Manual sample change and SIXPACK sample changer:

1. Type cfbacs  and answer the following question:

Which device is used for Sample Changer? tty20 

(or any unused RS232 port)

2. Click on OK to verify the error message

3. Type 6 for the sample holder capacity

7.2.8.2 Automatic sample changer.
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1. Type cfbacs and answer the following question:

Which device is used for Sample Changer? tty08

NOTE1: The configuration will check the connection between the computer and the
sample changer. Therefore be sure the sample changer is connected to the selected
RS232 port and the power is turned on.

Using barcode reader: no

Delay between SX and next command [sec]? 4

Is Airflow controlled by Sample Changer? yes (to use BACS

air)

no (to use BSMS

air)

7.3 How to set up the prosol parameters.

7.3.1 SUMMARY OF COMMANDS.

Configuration:

edhead set up the probehead table

solvloop setup probehead parameters for all solvents

prosol setup probehead parameters for one solvent
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edlock edit 2HLock file

7.3.2 SELECTION OF CURRENT PROBEHEAD

1. Type edhead

2. Click on ’Define current’

3. Select current probehead

4. Click on ‘seen’ in the message window

5. Click on 'SAVE'
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7.3.3 PROSOL AND TUNE FILE SET UP

1. Type solvloop

2. Select and click on current probehead

3. Edit the following parameters:

NOTE: choose only those nuclei which can be observed on the current probe. The
transmitter power levels and pulses below are starting values only which are to be
used in Chapter 3 ”OPTIMIZING PARAMETERS”. If the probe is already calibrat
enter the correct values in the appropriate fields.
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Proton power levels / pulses

L1H_tr 0 dB Proton transmitter high power level

P1H_tr 3 usec 1H Transmitter pulse

L1H_pr1 68 dB Proton power level for presaturation

P1H_pr1 2000000 usec 1H presaturation pulse

L1H_pr2 68 dB Proton power level II for presaturation

P1H_pr2 2000000 usec1H presaturation pulse II

P1H_roe 250000 usec 1H cw-pulse roesy (eg.250msec)

Proton decoupler power levels/pulses

L1H_hi 0 dB Proton decoupler high power level

13C power levels and pulses

L13C_tr 0 dB 13C transmitter high power level

P13C_tr 2 usec 13C transmitter pulse

L13C_hi 0 dB 13C decoupler high power level

P13C_hi 2 usec 13C decoupler high power pulse

15N power level and pulses

L15N_ tr 0 dB 15N high power level **

P15N_tr 3 usec 15N transmitter pulse **

19F power levels and pulses

L19F_tr 0 dB 19F high power level *
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P19F_tr 3 usec 19F transmitter pulse *

29SI power levels and pulses

L29Si_t 0 dB 29Si high power level **

P29Si_t 3 usec 29Si transmitter pulse **

31P power levels and pulses

L31P_tr 0 dB 31P high power level

P31P_tr 3 usec 31P transmitter pulse

Miscellaneous power levels and pulses

P_trim 2500 usec trim pulse (mlev)

P_hsqc 2000 usec trim pulse hsqc  **

L1H_noe 75 dB Proton power level for NOE-difference

P_grad 1000 usec gradient pulse  ***

D_grad 500 usec gradient recovery delay ***

* for QNP with 19F only

** for QNP with 15N or 29Si and BBI, BBO only

*** for probes with Gradients only

4. Click on ’SAVE’ and enter the password

5. Hit Return to answer y for the question: Edit tune file?

6. Display the line numbers and make the following changes:

insert Z and Z2 twice after line 32 and add a # at the beginning of the lines 37 and
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46.

NOTE: below is a printout of the modified section of the tune file

1 # Example of tunefile for BSMS Unit (2.0)95/01/25

2 # =====================================================================

3

4 ###

5 ###   All Gradient names must be written in capital letters !!!!

6 ###

7

8 DELAY 1 # wait 1 second between set_value and lock_read

9

10 MAXLOCK 3500 Show lock always on screen. Reduce LOCKGAIN

11 # if Lockvalue > 3500. (using BSMS-AutoGain)

12

13 # Two new options USE_LOCKLEVEL and USE_FIDAREA allows the modification

14 # of the paramter to be used for optimisation.

15 #     USE_LOCKLEVEL is set as default

16# The new option USE_FIDAREA starts the gs-command and read the FID area

17# after each scan (until the number of scans == LOCKDWELL). The mean value

18# is used for optimisation. With the option 

19# LOCK  off

20# or

21 # LOCK on

22

23LOCKDWELL 5 # redefine number of values, used to calculate 

24# a mean lock_value (Minimum 3, Maximum 32, default 5). The measure-

25# ment is repeated until the range of values of a straight line

26# fitted through all measured points is less than the total noise.

27# For each gradient which is to be shimmed, a line similar to the

28#  following is needed:

29

30# Shim_name Maximum_Step_Size Number_of_Iterations

31 Z 30 2

32 Z2 30 2

33 Z 15 2

34 Z2 15 2
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35 Z 10 2

36 Z2 10 2

37# Z3 10 3

38# The shim method is, to increase one shim value by step-size until the 

39# measured lock value decreases again. Then the step-size is reduced

40# according to the measured values. This is repeated number-of-iteration

41# times.

42# Z 5 3

43# Z2  5 3

44# Z3  5 3

45

46#AUTOSHIM Z=5 Z2=2

47# For BSMS all gradients are allowed for AUTOSHIM.

7. Store text and exit the editor

8. Hit Return to answer ‘y’ for the question: Store always the same parameter

7.3.4 LOCK FILE SET UP

Sample:  0.1% Ethyl benzene in CDCl3 or any sample in CDCl3

1. Insert sample into the magnet 

2. Type lock and select CDCl3

3. Press the ‘LOCK ON/OFF’ key on the BSMS panel (light should be off)

4. Center the lock trace within the lock window by changing the field value.
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4. Press the Lock ON/OFF key to lock (light should be on)

5. Shim for best resolution

6. Press Phase and adjust the phase, write the value down

7. Type edlock at the XWINNMR command line
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8. Click on ‘BSMS_FIELD’

NOTE: This procedure should be performed on a regular basis. (e.g. once a month)

9. Change the Lock Power value of all solvents as shown in the example belo

Solvent Lock Power Solvent Lock Power
Acetic -30 DMF -30

Acetone -36 DMSO -20

CDCl3 -27 Dioxane -30

CD2Cl2 -32 ETOH -30

CDC3N -30 MeOH -40
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C6D6 -30 THF -30

D2O -20 Tol -30

DEE -30 Pyr -30

DME -30

10. Change LGain value of Acetic to -2.1 and click on ‘COPY_VALUE’

11. Change LTime value of Acetic to 0.272 and click on ‘COPY_VALUE’

12. Change LFilter value of Acetic to 150 and click on ‘COPY_VALUE’

13. Change LPhase value of Acetic to value found in step 6 and click 

on  ‘COPY_VALUE’

14. Click on ‘SAVE’

15. Type lock CDCl3

NOTE: The system will enter the lockshift value of CDCl3 and automatically lock and
adjust the lock gain

7.4 Optimizing Parameters

7.4.1 SUMMARY OF COMMANDS

Acquisition:

asedautomatic setup editor

eda edit acquisition parameters
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ii initialize spectrometer interface

p1 - p31 pulse widths

pl1 - pl31 power levels

rga automatic receiver gain adjustment

rpar read parameter set

swh sweep width in Hz

wpar write parameter set

zg start acquisition

Pulse Programs:

decp90decoupler calibration

inv4ndrd1d1D inverse experiment with no decoupling

zg1D experiment with 90 degree pulse

zg301D experiment with 90 degree pulse

zgflqn1D 19F observe experiment

AU Programs:

paropt parameter optimization

Data:

edc create a new data set
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Processing:

edp edit processing parameters

ef em + ft

efp em + ft + pk

em exponential multiplication

ft fourier transform

pk phase correction using PHC0 and PHC1

NOTE: For precise measurement of any pulse calibration it is essential to tune the
probe to the observed nuclei.

7.4.2 DETERMINE THE 90o PULSE LENGTH FOR 1H

7.4.2.1 High power level for proton observe

 Sample: 0.1% Ethylbenzene in CDCl3

1. Type edc and change the following parameters:

NAME = test1h

EXPNO = 1

PROCNO = 1
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2. Click on ‘SAVE’

3. Type rpar PROTON all

4. Insert the sample into the magnet, type lock and select CDCl3, then shi
best homogeneity

5. Type eda and change the following parameters:

PULPROG = zg

TD = 4 K

NS = 1

DS = 0

D1 = 20s

SWH = 1000 Hz

O1p = 2.5 ppm

SOLVENT =  CDCl3

PROSOL = TRUE

6. Click on’ SAVE’

7. Type edp and change the following parameters:

SI = 2 K

LB = 1  Hz

PSCAL = global

8. Click on ‘SAVE’

9. Type ii

10. Type rga

11. Type zg
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12. Type ef

13. Correct the phase

14. Expand the spectrum to display the quartet at 2.6 ppm only

15. Click on ‘utilities’

16. Click on ‘O1’

17. Move the cursor into the center of the quartet and click the middle mouse
ton to               assign the O1 frequency

18. Click on ‘return’

19. Type ii

20. Type zg

21. Type efp

22. Click on ‘dp1’ and set the following parameters:

F1 = 2.9 ppm

F2 = 2.5 ppm

Change y-scaling on display according to PSCAL? = y

23. Type wpar protonp90 all

24. Type paropt and answer the following questions:

Enter parameter to modify: p1

Enter initial parameter value: 2

Enter parameter increment: 2

Enter # of experiments: 16
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NOTE: At the end of the experiment, a message: ”paropt finished” and a value f
is displayed. This will be the 90o pulse length for the 1H transmitter. Write this valu
down! To obtain a more accurate value, follow steps 25 through 30 below.

25. Type re 1 1

26. Type p1 and change the value to be a 360o pulse (multiply by 4 the value
observed in step 24)

27. Type zg

28. Type efp

29. Change p1 in small increments until the signal goes through a null at 360o

30. Simply divide the determined 360o value by 4. This will be the 90o pulse length
for the         1H transmitter using the current probehead

31. Type solvloop and enter the following parameters:

L1H_tr = 0
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P1H_tr = value determined in step 30

7.4.2.2 Low power level for MLEV spinlock

NOTE: To determine the power level for the MLEV spinlock, a 90o pulse length of 30-
35 usec is desirable.

1. Type re 1 1

2. Type p1 and change the value to 35 usec

3. Type paropt and answer the following questions:

Enter parameter to modify: pl1

Enter initial parameter value: 2

Enter parameter increment: 1

Enter # of experiments: 16

NOTE: At the end of the experiment, a message: ”paropt finished” and a value fo
is displayed. This will be the 1H transmitter power for a 90o pulse width of 35 usec.
Write this value down! To obtain a more accurate value, follow steps 4 throug
below. (Starting at 0 dB, increasing the attenuation by 6 dB, the pulse width sh
double).

4. Type re 1 1

5. Type pl1 and change to the value determined in step 3

6. Type pl and change the value to be a 360o pulse (multiply 35usec by 4)

7. Type zg

8. Type efp

9. Change p1 in small increments until the signals go through a null at 360o
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10. Simply divide the determined 360o value by 4

11. Type solvloop and enter the following parameters:

L1H_ml = (value determined in step 3)

P1H_mll = (value determined in step 10)

7.4.2.3 Low power level for ROESY spinlock

NOTE: To determine the power level for the ROESY spinlock a 90o pulse length of
140 - 160 usec is desirable.

1. Type re 1 1

2. Type p1 and change the value to 150 usec

3. Type paropt and answer the following questions:

Enter parameter to modify: pl1

Enter initial parameter value: 10

Enter parameter increment: 1

Enter # of experiments: 20

NOTE: At the end of the experiment, a message: ”paropt finished” and a value fo
is displayed. This will be the 1H transmitter power for a 90o value of 150 usec. Write
this value down! To obtain a more accurate value, follow steps 4 through 9 b
(Starting at 0 dB, increasing the attenuation by 6 dB, the pulse width should dou

4. Type re 1 1
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5. Type p1 and change the value to be a 360o pulse (multiply 150 usec by 4)

6. Type zg

7. Type efp

8. Change p1 in small increments until the signals go through a null at 360o

9. Simply divide the determined 360o value by 4

10. Type solvloop and enter the following parameters:

L1H_roe = (value determined in step 9)

P1H_roe = 250000  usec

7.4.3 DETERMINE THE 90o PULSE LENGTH FOR 13C

Sample: 80% Benzene in Acetone-d6

1. Type edc and change the following parameters:

NAME = test13c

EXPNO = 1

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar C13CPD all

4. Insert the sample into the magnet, type lock and select Acetone, then shi
best homogeneity

5. Type eda and change the following parameters:
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PULPROG = zg

TD = 4 K

NS = 1

DS = 0

D1 = 10 s

SWH = 1000 Hz

O1p = 127 ppm

SOLVENT = Aceton

PROSOL = TRUE

6. Type edp and change the following parameters:

SI = 2 K

PSCAL = global

7. Click on ‘SAVE’

8. Type ii

9. Type rga

10. Type zg

11. Type ef

12. Correct the phase (both peaks positive)

13. Expand the spectrum to display the doublet

14. Click on ‘utilities’

15. Click on ‘O1’

16. Move the cursor into the center of the doublet and click the middle mouse
ton to              assign the O1 frequency



7.4 Optimizing Parameters 109
DONE

INDEX

INDEX

17. Click on ‘return’

18. Type ii

19. Type zg

20. Type efp

21. Click on ‘dp1’ and set the following parameters:

F1 = 131 ppm

F2 = 127 ppm

Change y-scaling on display according to PSCAL? = y

22. Type wpar c13p90 all

23. Type paropt and answer the following questions:

Enter parameter to modify: p1

Enter initial parameter value: 2

Enter parameter increment: 2

Enter # of experiments: 16



110 Journey through ICON-NMR Setup

e for
is
low.
DONE

INDEX

INDEX

NOTE: An the end of the experiment, a message: ”paropt finished” and a valu
p1 is displayed. This will be the 90o pulse length for the 13C transmitter. Write th
value down! To obtain a more accurate value, follow the steps 24 through 29 be

24. Type re 1 1

25. Type pl and change the value to be a 360o pulse (multiply the value observed in
step 23 by 4)

26. Type zg

27. Type efp

28. Change p1 in small increments until the signals go through a null at 360o

29. Simply divide the determined 360o value by 4. This will be the 90o pulse
length for the        13C transmitter using the current probehead.

30. Type solvloop and enter the following parameters:

L13C_tr = 0

P13C_tr = (value determined in step 29)
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NOTE: WARNING! If the 90o pulse length is less then 5 usec for 5m probes and less
then 10 usec for 10mm probes, the probe is at risk of arcing. To prevent arcing,
change the transmitter power pl1 to a higher dB value and repeat steps 25 through
29.

7.4.4 DETERMINE THE 90o PULSE LENGTH FOR THE DECOUPLING 
NUCLEUS 1H

7.4.4.1 At high power

Sample: 80 % Benzene in Acetone-d6

1. Type edc and change the following parameters:

NAME = testdec

EXPNO = 1

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar c13p90 all

NOTE: if the parameter files c13p90 do not exist, follow the instructions in CHAPT.
3C steps 2 through 22.

4. Insert the sample into the magnet, type lock and select Acetone, then shim b



112 Journey through ICON-NMR Setup
DONE

INDEX

INDEX

    homogeneity

5. Type eda and set the following parameters:

PULPROG = decp90

O2p = 7.28

D2 = 3.125 ms

CNST[2] = 160

P3 = 2 us

PL2 = 0 dB

SOLVENT = ACETONE

PROSOL = TRUE

6. Click on ‘SAVE’

7. Type wpar decp90 all

8. Type rga

9. Type zg

10. Type ef

11. Correct the phase with the left signal up and the right down
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12. Increase p3 in increments of 1 or 2 usec, execute zg and efp until the signals
become zero. This is where p3 is 90o at maximum power.
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7.4.4.2 At low power for WALTZ decoupling

Sample: 80 % Benzene in Acetone-d6

1. Type edc and change the following parameters:

NAME = testdec

EXPNO = 2

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar decp90 all

NOTE: if the parameter files decp90 do not exist, follow the instructions in “At h
power” on page 111.

4. Insert the sample into the magnet, type lock and select Acetone, then shim best     
homogeneity

5. Increase pl2 and p3 until you find a 90 o  pulse between 100 and 120 usec ( start-
ing at 0dB, increase the attenuation by 6 dB, the pulse width should double). This
will be the 90o pulse for WALTZ   decoupling

6. Type solvloop and enter the following parameters:

L1H_hi = 0

L1H_lo = (pl2 value for WALTZ determined in step 5)

L1H_cpn = L1H_lo (for 5mm probes) = L1H_lo 

(for 10mm probes add 6dB)

P1H-hi = (p3 value determined in step 12)

P1H_lo = (p3 value for WALTZ determined in step 5)



7.4 Optimizing Parameters 115

m for
DONE

INDEX

INDEX

7.4.5 DETERMINE THE 90o PULSE LENGTH FOR INVERSE MODE

7.4.5.1 Determination of the 90o high power pulse for 13C in inverse mode

Sample: 10% CHCl3 in Aceton-d6(for instruments up to 300MHz)

                3% CHCl3 in Acetone-d6(for instruments 400MHz and up)

1. Type edc and change the following parameters:

NAME = testinv

EXPNO = 1

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar PROTON all

4. Insert the sample into the magnet, type lock and select Aceton, then shi
best                  homogeneity

5. Type eda and change the following parameters:

PULPROG = decp90

TD = 8 K

NS = 1

DS = 0

D1 = 5 s

D2 = 2.34 ms

SWH = 1000 Hz
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NUCLEI = click on edit and switch NUC2 to 13C

O1p = 8 ppm

O2p = 79 ppm

CNST[2] = 210 Hz

SOLVENT = Acetone

PROSOL = TRUE

6. Click on ‘SAVE’

7. Type edp and change the following parameters:

SI = 4 K

PSCAL = global

8. Type ii

9. Type rga

10. Type zg

11. Type ef

12. Display the Chloroform peak from 8.5 - 7.5 ppm to include the 13C satell

13. Correct the phase pointing the left satellite up and the right down
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14. Type wpar inv90 all

13. Type p3 and increase the value by 2 us

14. Type zg

15. Type efp

16. Repeat steps 13 through 15 until the intensity of the 13C satellites becomes
zero. This          value of p3 will be the 90o pulse length for the 13C channel in
inverse mode. Write               down this value!

17. Type solvloop and enter the following parameters:

P13C_hi = (p3 value from step16)

7.4.5.2 Inverse test experiment without 13C decoupling

Sample: 10% CHCl3 in Aceton-d6(for instruments up to 300MHz)
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                3% CHCl3 in Acetone-d6(for instruments 400MHz and up)

1. Type edc and change the following parameters:

NAME = testinv

EXPNO = 2

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar inv90 all

NOTE: if the parameter file inv90 do not exist, follow the instructions in “Determi
tion of the 90o high power pulse for 13C in inverse mode” on page 115.

4. Insert the sample into the magnet, type lock and select Aceton, then shim for
best homogeneity

5. Type eda and change the following parameter:

PULPROG = inv4ndrd1d

NS = 16

DS = 4

D1 = 20 s

D13 = 3 us

SOLVENT = Acetone

PROSOL = TRUE

 6. Click on ‘SAVE’
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 7. Type zg

 8. Type efp

 9. Correct the phase pointing both satellites up

7.4.5.3 Determination of the 90o low power pulse for 13C GARP decoupling.

Sample: 10% CHCl3 in Aceton-d6(for instruments up to 300MHz)

                3% CHCl3 in Acetone-d6(for instruments 400MHz and up)

NOTE: To determine the power level for 13C GARP decoupling a 90opulse length of
60 - 65 usec is desirable.

1. Type edc and change the following parameters:

NAME = testinv

EXPNO = 3
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PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar inv90 all

NOTE: if the parameter file inv90 do not exist, follow the instructions in “Determi
tion of the 90o high power pulse for 13C in inverse mode” on page 115.

4. Insert the sample into the magnet, type lock and select Aceton, then shim for
best homogeneity

5. Type eda and set the following parameters:

SOLVENT = Acetone

PROSOL = TRUE

6. Click on ‘SAVE’

7. Type p3 and change the value to 64 us

8. Type pl2 and increase the value by 2 dB

9. Type zg

10. Type ef

11. Correct the phase pointing the left satellite up and the right down

12. Repeat steps 9 through 11 using the command efp until the intensity of th
satellites       becomes zero. ( starting at 0dB, increase the attenuation by 6 d
pulse width should double). To determine an accurate null, the value of p3 m
varied. The final        value of p3 will be the 90o pulse length at low power for 13C
GARP decoupling.  Write       down this value!

13. Type solvloop and enter the following parameters:

L13C_lo = (pl2 value determined in step 12)

P13C_lo = (p3 value determined in step 12)
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7.4.6 DETERMINE THE 90o PULSE LENGTH FOR 19F

Sample: 0.05% Trfluorotoluene in CDCl3

.

1. Type edc and change the following parameters:

NAME = test19f

EXPNO = 1

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar F19 all

4. Insert the sample into the magnet, type lock and select CDCl3, then shim
best                  homogeneity

5. Type eda and change the following parameters:

PULPROG = zgflqn

TD = 4 K

NS = 1

DS = 0

D1 = 5 s

SWH = 1000 Hz

O1p = -63 ppm

SOLVENT = CDCl3

PROSOL = TRUE

6. Type edp and change the following parameters:
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SI = 2 K

PSCAL = global

7. Click on ‘SAVE’

8. Type ii

9. Type rga

10. Type zg

11. Type ef

12. Correct the phase

13. Expand the spectrum to display the signal at -63ppm only

14. Click on ‘utilities’

15. Click on ‘O1’

16. Move the cursor into the center of the peak and click the middle mouse bu

to assign the O1 frequency

17. Click on ‘return’

18. Type ii

19. Type zg

20. Type efp

21. Click on ‘dp1’ and set the following parameters:

F1 = -62.9 ppm

F2 = -63.1 ppm

Change y-scaling on display according to PSCAL? = y

22. Type wpar f19p90 all

23. Type paropt and answer the following questions:
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Enter parameter to modify: p1

Enter initial parameter value: 2

Enter parameter increment: 2

Enter # of experiments: 16

NOTE: An the end of the experiment, a message: ”paropt finished” appears a
value for  p1 is displayed. This will be the 90o pulse length for the 19F transmitter
Write this value down! 
To obtain a more accurate value, follow the steps 24 through 29 below.

24. Type re 1 1

25. Type pl and change the value to be a 360o pulse (multiply the value observed in
step 23 by 4)

26. Type zg

27. Type efp

28. Change p1 in small increments until the signals go through a null at 360o

29. Simply divide the determined 360o value by 4.  This will be the 90o pulse
length for the        19F transmitter using the current probehead

30. Type solvloop and enter the following parameters:

L19F_tr = 0

P19F_tr = (value determined in step 29)

NOTE: WARNING! If the 90o pulse length is less then 5 usec for 5m probes and 
then 10 usec for 10 mm probes, the probe is at risk of arcing. To prevent this from
pening, change the transmitter power pl1 to a higher dB value and repeat ste
through 29.
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7.4.7 DETERMINE THE 90o PULSE LENGTH FOR 31P

Sample: 0.0485 M Triphenylphophate in Acetone-d6

1. Type edc and change the following parameters:

NAME = test31p

EXPNO = 1

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar P31 all

4. Insert the sample into the magnet, type lock and select Acetone, then sh
best                  homogeneity

5. Type eda and change the following parameters:

PULPROG = zg

TD = 4 K

NS = 1

DS = 0

D1 = 15 s

SWH = 1000 Hz

O1p = -15 ppm

SOLVENT = Acetone

PROSOL = TRUE

6. Type edp and change the following parameters:
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SI = 2 K

LB = 1 Hz

PSCAL = global

7. Click on ‘SAVE’

8. Type ii

9. Type rga

10. Type zg

11. Type ef

12. Correct the phase

13. Expand the spectrum to display the signal at -16.4 ppm only

14. Click on ‘utilities’

15. Click on ‘O1’

16. Move the cursor into the center of the peak and click the middle mouse b
to assign the O1 frequency

17. Click on ‘return’

18. Type ii

19. Type zg

20. Type efp

21. Click on ‘dp1’ and set the following parameters:

F1 = -16.1 ppm

F2 = -16.7 ppm

Change y-scaling on display according to PSCAL? = y
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22. Type wpar p31p90 all

23. Type paropt and answer the following questions:

Enter parameter to modify: p1

Enter initial parameter value: 2

Enter parameter increment: 2

Enter # of experiments: 16

NOTE: An the end of the experiment, a message: ”paropt finished” appears a
value for  p1 is displayed. This will be the 90o pulse length for the 31P transmitte
Write these value down! 
To obtain a more accurate value, follow the steps 24 through 29 below.

24. Type re 1 1

25. Type pl and change the value to be a 360o pulse (multiply the value observed in
step 23 by 4)

26. Type zg

27. Type efp

28. Change p1 in small increments until the signals go through a null at 360o

29. Simply divide the determined 360o value by 4.  This will be the 90o pulse
length for the 31P transmitter using the current probehead

30. Type solvloop and enter the following parameters:

L31P_tr = 0

P31P_tr = (value determined in step 29)

NOTE: WARNING! If the 90o pulse length is less then 5 usec for 5m probes and 
then 10 usec for 10mm probes, the probe is at risk of arcing. To prevent this from
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pening, change the transmitter power pl1 to a higher dB value and repeat steps 25
through 29.

7.5 Set up of ICON-NMR

NOTE: It is only necessary to complete the steps in Chapter 4, if ICON-NMR is being
set up for the first time.  Please refer to the on-line ICON-NMR manual for customiza-
tion beyond what is shown here.

7.5.1 User Manager

1. Type iconnmr

2. Click on System Manager
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3. Click on User Manager

4. Enter NMR Super user password

5. Select a user name by clicking on it
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NOTE: If the Experiment List is blank click on ‘Default’ to load the default exp
ment list.

6. Click on the square button in the field ‘Exit (ICON-NMR)’ to allow permissi
to exit ICON-NMR 

7. Click on the square button in the field ‘Data Set Edit’ to allow permission to 
the Data Set Filename

8. Click inside the field ‘Partition Names’

9. Type the name of the disk partition where the data will be stored (e.g. u)

10. Click on ‘Append entry’

11. Click on ‘EXIT’

12. Click on ‘Save & EXIT’ in the Warning window

7.5.2 Composite Experiment Set up

1. Click on ‘Composite Experiment Setup’

2. Enter NMR Super user password
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3. Click on ‘Default’ to load the list of composite experiments

4. Click on ‘EXIT’

5. Click on ‘Save & EXIT’ in the Warning window

7.5.3 Configuration

1. Click on ‘Configuration’

2. Enter the NMR Super user password

3. Click on ‘Default Sample Changer Mode’ and select the operation mode th
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the system should default to.

4. Click on ‘Holder Status Display Style’ and select North American

5. Select the number of sample holders.  For Manual and SIXPACK operation
select 6 holders and for BACS enter 60 or 120 holders.

6. Click on ‘Default Shim Files’
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7. Click on the small square ‘Load default shim file before locking’

8. Click on the file icon of the current probe head

9. Select a good shim file for the current probe head in the directory:
/u/exp/stan/nmr/lists/bsms

NOTE: Select a shim file which can be used for running routine samples and update
this file regularly.

10. Click on ‘OK’

11. Click on ‘File’ and click on ‘EXIT’

12. Click on ‘Save & EXIT’ in the Warning window

13. Close the ICON-NMR System Manager window by clicking on ‘File’ and 
then on ‘EXIT’
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7.6 Routine Spectroscopy

NOTE: Routine Spectroscopy is designed to help users perform NMR experiments by
following a step by step menu.

1. Type iconnmr

2. Click on ‘Routine Spectroscopy’

3. Click on ‘Identify User’

4. Select user

5. Click on ‘OK’

6. Enter the password
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7. Click on ‘Inject/Eject’
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8. Click on ‘Insert Sample’ and wait until the ”Insert Sample” window appears

9. Insert your sample

10. Click on ‘OK’
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11. Type sample for Data Set Filename

12. Type 10 for Experiment No.

13. Click on ‘OK’

14. Click on ‘Continue’
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15. Select solvent e.g. CDCl3

16. Click on ‘Continue’

NOTE: If the data set name ”sample 10” already exists, a Data Set Report win
appears which gives the option to overwrite the existing data set or to incremen
experiment number to the next available one.
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17. Select the experiment  PROTON

18. Click on ‘Set Plot Title’



7.6 Routine Spectroscopy 139

ns
DONE

INDEX

INDEX

19. Click in the ”Plot Title Setup” window and enter a plot title

20. Click on ‘Save’

21. Click on ‘OK’

22. Click on ‘START’

NOTE: At this point an ”Online Control” window and the acquisition status ico
appear on the screen.
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Online Control function keys:

FID display the acquisition window 

(active after the acquisition has started

Lock view the lock window

Spectrum view the spectrum window

Halt stop the acquisition after the next scan 

is completed then start the processing

Plot plot data or additional expansions

EXIT to exit back to ICON-NMR/Routine window

Stop stop all processes and do not continue
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Search open the Portfolio Editor

23. Click on ‘EXIT’ after all processing status icons stop flashing

24. Click on ‘Eject + Terminate’

25. Remove your sample and insert another other sample if desired.

NOTE: It is generally better to keep a sample in the magnet if the instrument will not
be used for a long periods of time.
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7.7 Automation

NOTE: Automation is designed to run experiments using a variety of sample changers
and can also be used in manual sample change operation allowing greater flexibility
than “Routine Spectroscopy” on page 133.

7.7.1 SAMPLE SET UP

NOTE: The following setup examples are simple exercises to demonstrate the 
ent acquisition method in ICON-NMR using two samples.

Samples: ~0.3 M in 0.6 ml CDCl3 of a small organic molecule such as Strychnine

                ~0.3 M in 0.6 ml DMSO of a small organic molecule such as Carvone

                ~0.3 M in 0.6 ml CDCl3 of a small organic molecule such as Menthol

1. Type iconnmr

2. Click on ‘Automation’

3. Click on ‘Identify User’

4. Select user

5. Click on ‘OK’

6. Enter the user’s password

7.7.1.1 Set up of one single experiment



7.7 Automation 143

 and

lect
DONE

INDEX

INDEX

7. Double click on Holder 1

NOTE: The data is stored to disk ”u” by default.  The current date is the Name
the Exp No is the first free experiment number under that name.

8. Click inside the Name window and change the name to sample1

9. Click on the small button to the right of the solvent window and click on
”CDCl3”

10. Click on the small button to the right of the Experiment window and se
”PROTON” by clicking on it

NOTE: ”PROTON” is a single experiment and is marked with the letter N.

11. Click on the small icon to the left of the Orig/Title window and enter a title

12. Click on the first line of Holder 1

13. Click on ‘Submit’
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NOTE: The Status traffic light changes to yellow to indicate the holder is ready to run
and the experiment time is calculated.  Proceed to “SAMPLE RUN” on page 150
start the automation.

7.7.1.2 Set up of two single experiments

1. Follow steps 7 through 11 of “Set up of one single experiment” on page 14

2. Click on ‘Add’

NOTE: To add one experiment, regardless if it is a single or composite one, a
should be displayed in the window next to the ‘Add’ button.  A new line opens up
taining the same information for the Disk, Name, Solvent and Orig/Title.  The Ex
is incremented by 1.

3. Click on the small button to the right of the Experiment window and select
C13CPD32 by clicking on it
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4. Click on the first line of Holder 1

5. Click on ‘Submit’

NOTE: The Status traffic lights of the two experiments change to yellow to indicate
the holder is  ready to  run and the experiment time of each experiment is calculated.
Proceed to “SAMPLE RUN” on page 150 to start the automation.

7.7.1.3 Set up of a composite experiment

1. Follow steps 7 through 9 of “Set up of one single experiment” on page 142

2. Click on the small button to the right of the Experiment window and se
COSY45SW by clicking on it

NOTE: ”COSY45SW” is a composite experiment and is marked with the letter C
composite experiment contains two or more single experiments.  In this cas
”COSY45SW” is a 2D Homonuclear Correlation experiment which needs a prep
tion experiment ”PROTON” to prepare the ”COSY” experiment  to optimize the
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parameters.  The preparation experiment is entered automatically into the setup on
the present holder.  The system will check if a preparation experiment already exists
on the present holder so that it does not run the experiment twice.

4. Click on the small icon to the left of the Orig/Title window and type a title

5. Click on the first line of Holder 1

6. Click on ‘Submit’

NOTE: The Status traffic lights of the two experiments change to yellow to indicate
the holder is  ready to run and the experiment time of each experiment is calculated.
Proceed to “SAMPLE RUN” on page 150 to start the automation.

7.7.1.4 Set up of two composite experiments

1. Follow steps 7 through 9 of “Set up of one single experiment” on page 142

2. Click on the small button to the right of the Experiment window and se
COSY45SW by clicking on it

3. Click on the small icon to the left of the Orig/Title window and type a title

4. Click on ‘Add’

NOTE: To add one experiment, regardless if it is a single or composite one a
should be displayed in the window next to the ‘Add’ button.  A new line open
which contains the same information for the Disk, Name, Solvent and Orig/Title.
Exp No is incremented by 1.

5. Click on the small button to the right of the Experiment window and select
HCCOSW by clicking on it
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NOTE: ”HCCOSW” is a composite experiment like COSY45SW and is marked
the letter C.  It is a 2D Hetero Correlation experiment which needs two 1D prep
tion experiments to optimize the 2D parameters in both dimensions. In this 
”PROTON” and ”C13DEPT45” are used for  the optimization.  Since the ”PR
TON” experiment already exists, only the ”C13DEPT45” is automatically ente
into the setup on the present holder.

5. Click on the first line of Holder 1

6. Click on ‘Submit’

NOTE: The Status traffic lights of the four experiments change to yellow to indicate
the holder’s ready to run and the experiment time of each experiment is calcu
Proceed to “SAMPLE RUN” on page 150 to start the automation.

7.7.1.5 Set up of two or more holders with different solvents and experiments
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1. Follow steps 7 through 13 of “Set up of one single experiment” on page 14

2. Double click on  Holder 2

3. Click inside the Name window and change the name to sample2

4. Click on the small button to the right of the solvent window and select ”DMS
by clicking on it

5. Click on the small button to the right of the Experiment window and select
“C13CPD32” by clicking on it

6. Click on the small icon to the left of the Orig/Title window and type a title

7. Click on the first line of Holder 2

8. Click on ‘Submit’

NOTE: The Status traffic light changes to yellow to indicate the holder is ready to run
and the experiment time is calculated.   Proceed to “SAMPLE RUN” on page 15
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7.7.1.6 Set up of two or more holders with the same solvents and experiments

1. Follow steps 7 through 11 of “Set up of one single experiment” on page 14

2. Click on ‘Copy’

NOTE: To copy the setup from one holder into another holder click on the ‘copy’
ton.  The number displayed in the window next to the ‘Copy’ button is to how m
holders it will copy to.  For this example use ”1”.  The next holder will have the s
setup as the previous one except that the Exp No is incremented to the next n
divisible by 10 (e.g. 20).  To edit the new holder, follow the next steps below.

3. Click on the experiment line in holder 2

4. Click on ‘Edit’

5. Click on the small icon to the left of the Orig/Title window and change the ti

NOTE: In addition to the title all other entries can be edited in the new holder.  DO
NOT CHANGE!! the Exp No, unless you are sure the new Exp No does not already
exist.
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6. Click on the first line of holder 1

7. Press and hold the ”Shift” key

8. Click on the first line of holder 2

9. Release the ”Shift” key

NOTE: Both holders are now highlighted.

10. Click on ‘Submit’

NOTE: The Status traffic lights on both holders change to yellow to indicate the
holder’s ready to  run and the experiment time for each experiment is calcul
Proceed to “SAMPLE RUN” on page 150 to start the automation.

7.7.2 SAMPLE RUN

NOTE: Be sure that cfbacs has been done according to the instruction in “CON
URATION OF THE AUTOMATION” on page 89.

7.7.2.1 Manual Inject/Eject

NOTE: As an example set up to run under manual Inject/Eject mode, use the s
setup 7.7.1.1, 7.7.1.2, 7.7.1.3 or 7.7.1.4.

1. Click on ‘GO’
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NOTE: The ”Initialization Run” window appears.  The default ”Acquisition typ
displayed is what has been set in the ICON-NMR configuration.

2. Click on Acquisition type button and select ‘Manual Inject/Eject’

3. Select ”1” for First sample

NOTE: ICON-NMR gives you the option to lock and shim the sample prior to running
the Automation or if you have stopped or halted the previous automation run to con-
tinue on the sample already in the magnet.  For that purpose click on the small button
next to ”First sample in the magnet (locked and shimmed)?” and a check mark
appear.  The system will skip the inject/eject, locking and shimming for that sam

4. Click on ‘Start’

NOTE: At this point the ”ICON-NMR / Auto Online Controls” window and t
”acquisition status icons” appear.
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Online Control function keys:

FID display the acquisition window (active after the acquisition

has started)

Lock view the lock window

Spectrum view the spectrum window

Halt stop the acquisition after the next scan is completed

then start the processing

Plot plot data or additional expansions

EXIT exit back to ICON-NMR/Routine window

Stop stop all processes and do not continue
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Search open the Portfolio Editor

NOTE: The sample lift air will turn on and the ”Inject/Eject” window appears.

5. Insert sample

6. Click on ‘OK’

NOTE: At this point the Automation starts the tasks of locking, shimming, adjusting of
receiver gain, acquisition and processing.  A history box on the bottom of the ”A
mation Manager” window shows the detailed information of what tasks have 
completed or failed for experiment(s) that have been setup to run on the sample
After all experiments are finished, the sample lift turns on and the ”Inject/Eject” w
dow appears.

7. Remove the sample

NOTE: It is generally better to keep a sample in the magnet when the instrum
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not in use.

8. Click on ‘OK’

9. Click on ‘STOP’

10. Click on ‘Yes’

11. Click on ‘File’ and select ‘Close’

12. Click on ‘No’

NOTE: The Automation window closes and the Identify User icon appears.  At this
point the user may exit or a new user may log in to run the automation.
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7.7.2.2 Sixpack use

NOTE: As an example set up to run under Sixpack use mode, use the sample setup
7.7.1.5 or 7.7.1.6.

1. Turn the the switch on the sixpack controller box to OFF position

2. Turn on the sample lift (shim key pad) and remove the sample

!!!WARNING!!!  Be absolutely sure that no sample is in the magnet and the sample
holder is empty before proceeding to the next step.

3. With the sample lift air still on, move the sample holder to the start position (set
the small 

     hole over the shim stack)

4. Turn off the sample lift (from the key pad)

5. Load the samples into the sample holder

6. Turn the switch on the sixpack controller box to ON position

7. Click on ‘GO’

NOTE: The ”Initialization Run” window appears.  The default ”Acquisition typ
displayed is what has been set in the ICON-NMR configuration.
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2. Click on Acquisition type button and select ‘Sixpack use’

3. Select ”1” for First sample

NOTE: ICON-NMR gives you the option to lock and shim the sample prior to running
the Automation or if you have stopped or halted the previous automation run to con-
tinue on the sample already in the magnet.  For that purpose click on the small button
next to ”First sample in the magnet (locked and shimmed)?” and a check mark
appear.  The system will skip the inject/eject, locking and shimming for that sam

4. Click on ‘Start’

NOTE: At this point the ”ICON-NMR / Auto Online Controls” window and t
”acquisition status icons”  appear.
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NOTE: The Automation starts the tasks of changing the sample, locking, shimming,
adjusting of receiver gain, acquisition and processing.  A history box on the bottom of
the ”Automation Manager” window shows the detailed information of what ta
have been completed or failed for experiment(s) that have been setup to run 
samples. For a definition of the Online Control function keys, see ’Online Co
function keys:’ on page 152.

5. Wait until the last sample has finished running and has been ejected

6. Click on ‘STOP’
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7. Click on ‘Yes’

8. Turn the switch on the sixpack controller box to OFF

9. Remove all samples from the sample holder

10. Click on ‘File’ and select ‘Close’

11. Click on ‘No’

NOTE: The Automation window closes and the Identify User icon appears.  At this
point the user may exit or a new user may log in to run the automation.

7.7.2.3 Standard BACS

NOTE: As an example set up to run under Standard BACS mode, use the sample setup
7.7.1.5 or 7.7.1.6.
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1. Insert the samples into the holders 1 and 2

3. Press RESET on the front of the sample changer

4. Click on ‘GO’

NOTE: The ”Initialization Run” window appears.  The default ”Acquisition typ
displayed is what has been set in the ICON-NMR configuration.

5. Click on Acquisition type button and select ‘Standard BACS’

6. Select ”1” for First sample

NOTE: ICON-NMR gives you the option to lock and shim the sample prior to running
the Automation or if you have stopped or halted the previous automation run to con-
tinue on the sample already in the magnet.  For that purpose click on the small button
next to ”First sample in the magnet (locked and shimmed)?” and a check mark
appear.  The system will skip the inject/eject, locking and shimming for that sam

7. Click on ‘Start’
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NOTE: At this point the ”ICON-NMR / Auto Online Controls” window and t
”acquisition status icons”  appear.

NOTE: The Automation starts the tasks of changing the sample, locking, shim
adjusting of receiver gain, acquisition and processing.  A history box on the botto
the ”Automation Manager” window shows the detailed information of what ta
have been completed or failed for experiment(s) setup to run on the samples.
For the definition of Online Control function keys see ’Online Control function ke
on page 152.
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8. Wait until the last sample has finished running and has been ejected and put
back into the holder

9. Click on ‘STOP’

7. Click on ‘Yes’

8. Click on ‘File’ and select ‘Close’

9. Click on ‘No’

NOTE: The Automation window closes and the Identify User icon appears.  At this
point the user may exit or a new user may log in to run the Automation or exit ICON-
NMR.
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7.8 Adding new experiments

7.8.1 Adding a new single experiment

!!!IMPORTANT!!!:  Before creating a new experiment for automation make a layout
of how the new experiment should work and how you would like to present the result.
Check the parameter library first to see if the new experiment already exists.  If not,
check in the pulse program library for an existing pulse program and in the au pro-
gram library for the acquisition and processing programs to satisfy the plans for the
new experiment.  If you have to create a new pulse program or have to write an au
program, be sure to follow to the nomenclature of file names, pulse widths  and delay
numberings that Bruker has defined.  Any deviation may result in a malfunction of the
new experiment.  Always test out the new experiment before you add it to ICON-NMR.

7.8.1.1 Layout of the new experiment

Experiment: attached proton experiment (APT)

Parameter file: C13DEPT135

Pulse program: jmod

Au programs: aunm au_zg

aunmp proc_1d

7.8.1.2 Creating the parameter file

NOTE: In this case the APT experiment does not exist in the parameter set library and
it has to be  created.  Since the acquisition and processing of APT is similar to the
DEPT135 experiment, the parameter file C13DEPT135 can be used as a template for
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creating the new experiment.

1. Type edc and change the following parameters:

NAME = newexp

EXPNO = 1

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar C13DEPT135 all

4. Type pulprog jmod

NOTE: The only change necessary in the parameters, is the pulse program.  If
desired, number of scans ‘ns’ or relaxation time ‘d1’ may be changed.

5. Type wpar C13APT all

NOTE: The parameter files for C13APT are now stored in the directory /u/exp/
nmr/par and before being added to the experiment list in ICON-NMR it shoul
tested on a sample.

7.8.1.3 Testing the experiment

Sample: ~0.3 M in 0.6 ml CDCl3 of a small organic molecule such as Cholestery-
lacetate

1. Type edc and change the following parameters:
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NAME = newexp

EXPNO = 2

PROCNO = 1

2. Click on ‘SAVE’

3. Type rpar C13APT all

4. Type lock and select CDCl3 by clicking on it

5. Wait until the locking process is finished, then shim for best homogeneity

6. Type eda and change the following parameters:

PROSOL TRUE

7. Click on ‘SAVE’

8. Type rga

9. Type zg

10. Type ef

11. Correct the phase by making the CH3  and  CH carbons of the same pha
the CH2  and C carbons of opposite phase.  The relative phase is arbitrary.
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NOTE: Repeat step 8 through 11 if you want to make changes in the parameters.
Apply the changes in the parameter file C13APT.

7.8.1.4 Adding the new experiment to ICON-NMR

1. Type iconnmr

2. Click on ‘System Manager’

3. Click on ‘User Manager’

4. Enter the NMR Super user password

5. Select a ”user name” by clicking on it

6. In the Experiment List open an entry box by clicking on ”C13CPD”

7. Click on the ‘box (down arrow)’ next to the Experiment Name

!!!WARNING!!! The list of names shown in the pop up window are parameter files
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which are stored in the /u/stan/exp/nmr/par directory.  Not all of the files are suitable
to run in Automation.  Some files require additional operator input in order to be used
as an experiment (e.g. SELCO1H, NOEDIFF etc.).  Other files are not possible to run
in ICON-NMR (e.g. plot135, standard1D etc.).

8. Select ”C13APT” by clicking on it

9. Click on Experiment Comment Text window and enter the following text:

C13 attached Proton test

NOTE: The Experiment Type is Normal, indicating a single experiment.
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10. Click on ‘Append entry’

NOTE: The new experiment has now been added to the Experiment List.  To move the
entry to a different place in the list, click and hold the right mouse button on the name
and drag it to the desired location.

11. Click on ‘EXIT’ (Entry Box)

12. Click on ‘Save’

13. Click on ‘Save’

14. Click on ‘EXIT’

15. Select ”File” from the menu bar by clicking on it

16. Select ”EXIT” by clicking on it

NOTE: Test the new added experiment with Routine Spectroscopy or Automation for



168 Journey through ICON-NMR Setup

ction
peri-
DONE

INDEX

INDEX

proper operation.

7.8.2 ADDING A NEW COMPOSITE EXPERIMENT

!!!IMPORTANT!!!: Before creating a new Composite experiment, make a layout of
how the new experiment should work and how you would like to present the result.
Check the parameter library first to see if the experiments of interest for the compos-
ite already exist.  If they don’t, create the experiment by following the steps in se
“Adding a new single experiment” on page 162.  Always test out the single ex
ment outside ICON-NMR according “Testing the experiment” on page 163.

7.8.2.1 Layout of the new composite experiment
Experiments: 1D-Proton followed by a 2D-COSY45 and a 1D-

APT

Parameter files: PROTON, COSY45SW, C13APT

Name: PROCOSAPT

7.8.2.2 Creating the new composite experiment

1. Type iconnmr

2. Click on ‘System Manager’

3. Click on ‘Composite Experiment Setup’

4. Enter NMR Super user password
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5. Click on ‘Add new’

6. Type the following text into the ”Add/Modify Name & Comment” window:

Name: PROCOSAPT

Comment: Proton, COSY45, APT
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7. Click on ‘Names’ in the ”Add/Modify Component” Window

8. Select ”PROTON” from the pop up window by clicking on it.  (Click twice 
”next page” until PROTON appears).

9. Click on ‘Append entry’

10. Click on ‘Names’

11. Select ”COSY45SW” from the pop up window by clicking on it.

12. Click on ‘F2 Ref’

13. Select ” PROTON” by clicking on it

14. Click on ‘Append entry’

15. Click on ‘Names’

16. Select ”C13APT” from the pop up window

17. Click on ‘Append entry’
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18.Click on ‘OK’

NOTE: The new composite experiment has now been added to the Composite Experi-
ment List in the Composite Experiment Manager.  To add this experiment to the user
experiment list, stay in this manager window and follow the next steps.

7.8.2.3 Adding the new composite experiment to the user experiment list

1. Click on the new experiment ”PROCOSAPT”

2. Click on ‘Save to’

3. Click on the user that will be allowed to access the new composite experim

NOTE: To select multiple users, hold down the Shift key when selecting them.

4. Click on ‘Save to selected users’

5. Click on ‘Cancel’

6. Click on ‘EXIT’
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7. Click on ‘Save & EXIT’

8. Select ”File” from the menu bar by clicking on it

9. Select ”EXIT” by clicking on it

NOTE: Test the new composite experiment with Routine Spectroscopy or Automation
for proper operation.
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ICON-NMR Comment Form

Name / Institution / Company: 
.....................................................................................................................................................

.....................................................................................................................................................
Address:
.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................
Phone /Fax /E-mail:
.....................................................................................................................................................
Spectrometer / Computer:
.....................................................................................................................................................
Operating System / ICON-NMR Version:
.....................................................................................................................................................
Comments / Error report / Suggestions (continue on extra sheet if required):
.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

.....................................................................................................................................................

(Please mail to software support group. The address is printed on the second manual page.)
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